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Marcas Registradas 

El logotipo DCI, DataLog
®
, DigiTrak

®
, Eclipse

®
, F5

®
, MFD

®
,
 
SST

®
, y TensiTrak

® 
son marcas registradas

en los EE.UU. y Ball-in-the-Box™, F Series™, FSD™, y LWD™ son marcas registradas de Digital 
Control Incorporated. Bluetooth es una marca registrada de Bluetooth SIG Inc. 

Patentes 

Las patentes de los EE.UU. y extranjeras se aplican al producto cubierto por este manual. Para 
conocer más detalles, por favor visite www.DigiTrak.com/patents. 

Garantía limitada 

Todos los productos manufacturados y vendidos por Digital Control Incorporated (DCI) están sujetos a 
los términos de una Garantía Limitada. Al final de este manual se incluye una copia de la Garantía 
Limitada; también puede obtenerse al comunicarse con el Departamento de Servicio al Cliente de DCI, 
al +1-425-251-0559 o al 800-288-3610 (US/CAN), o bien conectándose al sitio web www.DigiTrak.com. 

Aviso importante 

Todas las declaraciones, información técnica y recomendaciones relacionadas con los productos de 
DCI se basan en información que se cree es confiable. Sin embargo, DCI no asevera ni garantiza la 
exactitud o integridad de dicha información. Antes de utilizar cualquier producto DCI, el usuario debe 
determinar lo apropiado del producto para el uso que se pretende. Todas las declaraciones dentro de 
este documento se refieren a productos de DCI, entregados por DCI, para su uso en la perforación 
direccional horizontal (HDD) en el curso ordinario, y no se aplican a alguna personalización del usuario, 
productos de terceros, o algún otro uso del producto DCI fuera del curso ordinario. Nada de lo aquí 
expuesto se constituirá como garantía por parte de DCI, ni se considerará una modificación de los 
términos de la garantía limitada existente de DCI aplicable a todos los productos de DCI. DCI puede 
actualizar o corregir periódicamente la información de este manual. Usted puede encontrar la versión 
más reciente de este manual en la página web de DCI, www.DigiTrak.com. Estando en Service & 
Support (Servicio y Apoyo), haga clic en Documentation (Documentación) y seleccione en el menú 
desplegable Manuals (Manuales). 

Declaración de conformidad 

Este equipo cumple con la Parte 15 de las Reglas de la FCC y con las normas RSS exentas de licencia 
de Industry Canada y con Australia Class License 2000 para los LIPD (dispositivos de bajo potencial de 
interferencia). La operación está sujeta a las dos condiciones siguientes: (1) este equipo no causa 
interferencia dañina, y (2) este equipo debe aceptar toda interferencia recibida, incluyendo 
interferencias que pudiesen causar una operación no deseada. DCI es responsable por el cumplimiento 
de la norma FCC de los Estados Unidos: Digital Control Incorporated, 19625 62nd Ave S, Suite B103, 
Kent WA 98032, EE.UU.; teléfonos 425-251-0559 u 800-288-3610 (EE.UU. y Canadá solamente). 

Los cambios o modificaciones hechos a cualquier equipo DCI, y que no hayan sido expresamente 
aprobados y llevados a cabo por DCI anularán la garantía limitada y la autorización de la FCC para 
operar el equipo del usuario. 

Requisitos de la CE 

  Los receptores DigiTrak se clasifican como equipos de radio de Clase 2 de acuerdo a la 
Directiva R&TTE y pudiera ser que en algunos países no sea legal operarlos o que se requiera de una 
licencia para su operación. La lista de las restricciones y las declaraciones de conformidad requeridas 
se encuentran disponibles en el sitio web de DCI, www.DigiTrak.com. Estando en Service & Support 
(Servicio y Apoyo), haga clic en Documentation (Documentación) y seleccione en el menú 
desplegable CE Documents (Documentos CE). 

http://www.digitrak.com/patents
http://www.digitrak.com/
http://www.digitrak.com/
http://www.digitrak.com/
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Contáctenos 

Estados Unidos 

Casa Matriz DCI 

19625 62nd Ave S, Suite B103 

Kent, Washington 98032, EE.UU. 

+1.425.251.0559/1.800.288.3610 

+1.425.251.0702 fax 

dci@digital-control.com 

Australia 2/9 Frinton Street 

Southport QLD 4215 

+61.7.5531.4283 

+61.7.5531.2617 fax 

dci.australia@digital-control.com 

China 368 Xingle Road 

Huacao Town 

Minhang District 

Shanghai 201107, R.P.C. 

+86.21.6432.5186 

+86.21.6432.5187 fax 

dci.china@digital-control.com 

Europa Brueckenstraße 2 

97828 Marktheidenfeld 

Alemania 

+49.9391.810.6100 

+49.9391.810.6109 fax 

dci.europe@digital-control.com 

India DTJ 1023, 10th Floor 

DLF Tower A, DA District Center 

Jasola, New Delhi 110044 

+91.11.4507.0444 

+91.11.4507.0440 fax 

dci.india@digital-control.com 

Rusia Molodogvardeyskaya Street, 4 

Building 1, Office 5 

Moscow, Rusia 121467 

+7.499.281.8177 

+7.499.281.8166 fax 

dci.russia@digital-control.com 

 

mailto:dci@digital-control.com
mailto:dci.australia@digital-control.com
mailto:dci.china@digital-control.com
mailto:dci.europe@digital-control.com
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mailto:dci.russia@digital-control.com
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Estimado Cliente, 

Gracias por elegir un Sistema de Localización DigiTrak. Estamos muy orgullosos del equipo 
que hemos estado diseñando y produciendo en el Estado de Washington desde el año 1990. 
Estamos comprometidos a suministrarle un producto excepcional, de alta calidad y 
respaldado con un servicio y capacitación al cliente de calidad superior. 

Por favor, disponga de unos momentos para leer todo el manual, especialmente la sección 
referente a seguridad. Por favor, también registre su equipo en línea en 
access.DigiTrak.com. O llene por favor la tarjeta de inscripción del producto para su equipo, 
y envíela por fax al 253-395-2800 o por correo a la casa matriz de DCI. 

La inscripción de este producto le da derecho a apoyo telefónico gratuito (en los EE.UU. y 
Canadá), a notificación de actualizaciones del producto y del manual de instrucciones y nos 
ayuda a proporcionarle información de futuras mejoras del producto. 

Siéntase en confianza para contactarnos si tiene algún problema o pregunta. Nuestro 
Departamento de Servicio al Cliente está disponible las 24 horas del día, los 7 días de la 
semana. En nuestro sitio web se encuentra la información de los contactos internacionales. 

Mientras crece la industria de perforación direccional horizontal, nosotros estamos muy 
atentos al futuro para desarrollar el equipo que le hará su trabajo más rápido y más fácil. 
Visítenos en la línea, en cualquier momento, para ver qué hay de nuevo. 

Son bienvenidas las preguntas, comentarios e ideas. 

Digital Control Incorporated 
Kent, Washington 
2015 

 

Vea nuestros videos DigiTrak de capacitación en 
www.youtube.com/dcikent 

 

file://///DCI-FS01/Shared%20Documents/Document%20Library/_In%20Dev/403-3300%20F5%20DataLog-LWD%20OM/English/access.DigiTrak.com
http://www.youtube.com/dcikent
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Instrucciones de seguridad importantes 

Opere siempre su sistema de localización DigiTrak en forma correcta para obtener precisión 
en las mediciones de profundidad, inclinación, balanceo y para localizar puntos. Si usted 
tiene alguna pregunta acerca de la operación del sistema, por favor póngase en contacto con 
el Departamento de Servicio al Cliente de DCI para obtener ayuda. 

Este manual es un compañero de su manual del operador del sistema de localización, el cual 
contiene una lista más exhaustiva de advertencias relacionadas con el potencial de lesiones 
severas y muerte, retardos en el trabajo, daño a la propiedad y otros riesgos y advertencias 
relacionadas con la operación del equipo de perforación horizontal. Por favor, lea y 
comprenda completamente su manual del operador del sistema antes de operar el equipo 
descrito en este manual. 



DIGITAL  CONTROL  INCORPORATED  

Manual del Operador DataLog/LWD™ DigiTrak 1 

Introducción 

      

Datos de perforación y presión en DataLog; Receptores F5 y Eclipse 

El sistema
 
DataLog 

DigiTrak le permite recopilar y almacenar datos de perforación en un 

receptor F5
 
o Eclipse 

y después cargarlo en una computadora para almacenamiento y 
análisis, utilizando el software Log-While-Drilling (LWD™) de DCI. El sistema DataLog puede 
medir y grabar los siguientes tipos de datos:  

 Profundidad  

 Inclinación 

 Cambio de elevación (topografía de la superficie) 

 Presión del fluido (requiere de un transmisor de presión del fluido F5) 

 Fuerza de extracción y presión del fluido (requiere de un transmisor TensiTrak) 

 Información del rumbo del transmisor (requiere de un transmisor de direccionamiento 

SST) 

Este manual cubre la función DataLog, principalmente en un receptor F5; aunque están 
incluidas algunas instrucciones para el sistema Eclipse, los usuarios deben consultar 
también el Manual del Operador del Sistema de Cartografiado Eclipse DataLog DigiTrak 
disponible en la página web de DCI. 

Tal como se mencionó anteriormente, el sistema DataLog trabaja con los transmisores 
TensiTrak y SST. Para obtener información completa sobre el transmisor TensiTrak y el 
sistema de direccionamiento SST, por favor consulte el manual del operador respectivo, 
disponible en www.DigiTrak.com. 

Los términos y técnicas utilizados en este manual son considerados básicos para el sistema 
de localización F5 DigiTrak y Eclipse. Usted debe leer y comprender su manual del operador 
del sistema y familiarizarse con los diferentes menús DataLog en su receptor antes de 
utilizar el sistema para una perforación de producción. Si tiene preguntas, por favor llame al 
Servicio al Cliente de DCI para obtener ayuda. 

Ajustar la hora y el calendario 

Antes de registrar datos, debe ajustar la fecha y hora correcta en su receptor F5. La opción 
para ajustar la hora y el calendario está disponible en la opción de "Settings" 
(Configuraciones) en el menú principal. Para obtener ayuda adicional en el ajuste de la hora 
y fecha para su receptor, consulte su manual del operador. 

http://www.digitrak.com/customerservice/downloads
http://www.digitrak.com/
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Componentes del sistema 

El sistema DataLog DigiTrak tiene cuatro componentes principales: 

Receptor F5 ó Eclipse Un receptor (localizador) con menús DataLog usados para 
mostrar y grabar los datos del transmisor. 

Transmisor F5, 
F Series o Eclipse Un dispositivo energizado por medio de una batería o cable, 

ubicado en el cabezal de perforación, con sensores que miden y 
transmiten continuamente información acerca del cabezal de 
perforación o de la fuerza de extracción del producto que se 
encuentra por debajo del terreno. Esta información se muestra 
en el receptor F5. 

Software LWD La aplicación de computadora usada para descargar y trabajar 
con los datos de perforación DataLog de un receptor. 

Adaptador de carga Un dispositivo USB requerido para que la computadora 
descargue datos de un receptor F5, ó de un dispositivo de cable 
en serie infrarrojo requerido para descargar datos de un receptor 
Eclipse. 

Receptor 

El receptor rastrea la posición y la profundidad del transmisor y graba los datos de 
perforación y de extracción. El receptor F5 puede grabar y almacenar 50 trabajos (tramos) 
según el tipo de archivo DataLog (datos de perforación o de presión-tensión) antes de que 
alguno o todos los trabajos deban ser eliminados o cargados a una computadora para crear 
espacio para trabajos nuevos. Cada trabajo de datos de perforación puede tener cientos de 
puntos de datos. El número de puntos de datos que pueden ser guardados en cada trabajo 
DataLog de presión-tensión, solamente depende de la cantidad de memoria disponible en el 
receptor F5. 

Eclipse: Este manual le da instrucciones para utilizar las funciones de DataLog en un 
receptor F5; si usted está usando un receptor Eclipse, consulte el Manual del Operador del 
Sistema de Cartografiado Eclipse DataLog DigiTrak disponible en nuestra página web. 

Transmisor 

La función DataLog grabará los datos del transmisor desde todos los transmisores F5, 
F Series y Eclipse operados con batería y cableados. Esto incluye el F5 TensiTrak, el cual 
proporciona ambas lecturas, la de presión del fluido y la de la fuerza de extracción del 
producto, y la herramienta de direccionamiento SST, la cual proporciona guía de rumbo del 
cable sin un emparrillado. 

Los datos de perforación estándar provistos por un transmisor incluyen la profundidad y la 
inclinación. Un Transmisor de Presión de Fluido (FPT, por sus siglas en inglés) también 
proporciona lecturas de presión de fluido promedio, alta y máxima por varilla. Para obtener 
un registro que incluya ambos datos, de perforación y de presión, usted debe grabar tanto un 
trabajo de datos de perforación, como un trabajo de datos de presión-tensión (P-T) al mismo 
tiempo, ya que la profundidad y la inclinación no son grabadas en un archivo de datos de 
presión-tensión. 

http://www.digitrak.com/customerservice/downloads.html
http://www.digitrak.com/customerservice/downloads.html
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El transmisor y el receptor deben ser compatibles para grabar datos. El receptor F5 es 
compatible tanto con los transmisores F5, como con los F Series (se aplican los requisitos de 
compatibilidad regional). El receptor Eclipse es compatible solamente con los transmisores 
Eclipse. 

Software LWD 

El software Log-While-Drilling (Registro-al-Perforar, LWD™) es suministrado en una unidad 
flash USB, que contiene también este manual del operador, el manual del operador del 
sistema, datos muestra de perforación y controladores Bluetooth. 

 

Unidad flash USB LWD 

El software requiere de una computadora con las siguientes especificaciones mínimas: 

 Sistema operativo Microsoft
 
Windows

 
XP, Microsoft Windows Vista, Microsoft 

Windows 7, ó Microsoft Windows 8 

 Puerto USB 

 Dispositivo señalador (ratón) 

 Impresora (opcional) 

Adaptador USB para Bluetooth 

El adaptador USB para Bluetooth (Amp’ed RF Modelo BT-210) se conecta en su 
computadora para permitir que el receptor cargue los datos. Los controladores para el 
adaptador Bluetooth son proporcionados en la unidad flash LWD y deben cargarse antes de 
usarse; ver Instalación del Software LWD en la página 23. 

 

Adaptador USB para Bluetooth 

Para Eclipse: Se requiere un cable ACTiSYS infrarrojo (IR) para cargar los datos desde un 
receptor Eclipse. Coloque el lector IR en el puerto IR del receptor y conecte el enchufe en 
serie a la computadora. 

Si su computadora no tiene un puerto en serie, use el adaptador de serie a USB 
proporcionado con el cable IR. El controlador "Prolific" requerido para este adaptador se 
incluye en la unidad flash. 
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Entendiendo DataLog 

El informe incorporado que usted ve en el programa Log-While-Drilling depende de lo que 
grabe en su receptor. Las siguientes secciones describen los cinco tipos de informes que 
DataLog puede generar en Log-While-Drilling. 

Su receptor graba la mayoría de los datos del transmisor usando un trabajo DataLog de 
perforación. La presión del fluido y la fuerza de extracción TensiTrak se graban 
separadamente en un trabajo DataLog de presión-tensión. Para ver ambos conjuntos de 
datos en una gráfica, ambas grabaciones deben hacerse al mismo tiempo. 

 

Nota La función DataLog debe ser activada antes de que un trabajo pueda 
iniciarse, detenerse o adjuntarse. Del menú principal, seleccione DataLog de 

perforación  y/o DataLog de presión-tensión , seleccione el icono 

rojo Desactivado…  de tal manera que se vuelva verde  

(activado), y seleccione Salir  para regresar al menú principal. 

Datos del transmisor estándar 

Para grabar los datos del transmisor estándar, tal como número de varilla, la profundidad y la 
inclinación, inicie un trabajo DataLog de perforación (ver Grabación de datos en la página 
11). Estos datos aparecerán así en el programa Log-While-Drilling (LWD): 

 

Solamente datos de perforación 

Barra de menús 

Información 

del sitio 

Información 

del trabajo 

Barra de herramientas 

Área de gráfica 

Barra de estado 

Lista de puntos de datos 
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Datos del transmisor estándar con presión del fluido 

Seleccione un transmisor FPT en la pantalla de selección del transmisor. Al acceder a la 
pantalla de localizar, el receptor le pedirá automáticamente iniciar un trabajo DataLog de P-
T. Después de iniciar el trabajo de P-T y regresar a la pantalla de localizar, sostenga el 
gatillo brevemente y conmute a la derecha para iniciar un trabajo DataLog de perforación 
simultáneo (ver Grabación de datos en la página 11). 

 

Datos de perforación con presión del fluido 

Datos de presión del fluido sin datos de perforación 

Para grabar solamente la presión del fluido, inicie un trabajo DataLog de presión-tensión tal 
como se discutió en la sección previa, pero no inicie un trabajo DataLog de perforación 
simultáneo. Debido a que no existen datos de la varilla de perforación para ser agrupados en 
parejas con los datos de presión, la gráfica LWD resultante mostrará sólo los datos sin 
procesar de la presión de fluidos basados en el tiempo. 

 

Presión del fluido solamente 

 

Profundidad 

Presión del fluido 



DIGITAL  CONTROL  INCORPORATED 

6 Manual del Operador DataLog/LWD™ DigiTrak 

Datos de la fuerza de extracción TensiTrak y de la presión 
del fluido 

Para grabar la presión del fluido y la fuerza de extracción usando un transmisor de 
extracción TensiTrak, inicie un trabajo DataLog de P-T. Debido a que no está instalado un 
transmisor en la perforación piloto durante la extracción del producto, las gráficas TensiTrak 
tienen la misma apariencia dentada, tal como un trabajo de presión del fluido sin datos de 
perforación. 

 

Fuerza de extracción TensiTrak y de la presión del fluido, sin datos de perforación 

Para una discusión completa de cómo usar y grabar datos para un transmisor TensiTrak, por 
favor consulte el Manual del Operador de TensiTrak, disponible en www.DigiTrak.com.  

Presión 

Fuerza 

http://www.digitrak.com/
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Datos de la herramienta de direccionamiento (SST) 

Para grabar elevación, perfil trayectoria de perforación y desviación izquierda/derecha, el 
transmisor de la herramienta de direccionamiento SST no utiliza la función DataLog. En lugar 
de ello, se requiere la ejecución del software LWD, en vivo, en una computadora portátil 
conectada al equipo de perforación durante la perforación. 

 

Datos de elevación y curso de transmisor 
de la herramienta de direccionamiento (SST) LWD 

Para una discusión completa de cómo usar y grabar datos para un transmisor SST, por favor 
consulte el Manual del Operador de SST, disponible en www.DigiTrak.com. 

Vista de dos dimensiones 

de la perforación 

Desviación izquierda/derecha 

(vista aérea) 

http://www.digitrak.com/
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Menús DataLog del receptor 

Desde el menú principal del receptor F5, conmute hacia abajo dos veces para mostrar las 

opciones del menú de DataLog de perforación  y DataLog de presión-tensión  

(P-T) . 

 

Segunda pantalla del menú principal del receptor F5 

Menú DataLog de perforación  

Use el menú DataLog de perforación  para grabar los datos de la perforación piloto.  

 

Menú DataLog de perforación  

DataLog de perforación  

DataLog de Presión-

Tensión (P-T)  

Descripción de la opción 

resaltada 

Eliminar trabajo(s) 

DataLog 

Agregar punto de 

medición 

Ver trabajos DataLog 

Configurar un trabajo 

DataLog de perforación 

Cargar el trabajo DataLog de 

perforación a una computadora 

Activar/desactivar la función DataLog 
de perforación (verde si está activada, 

rojo si está desactivada) 
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Menú DataLog de Presión-Tensión (P-T)  

Use el menú DataLog de Presión-Tensión (P-T)  para grabar la presión del fluido. Al 
acceder a la pantalla de localizar, el receptor le pedirá automáticamente iniciar un trabajo 
DataLog de P-T. 

 

Menú DataLog de Presión-Tensión (P-T)  

Un trabajo DataLog de perforación graba todos los datos del transmisor distintos de la 
presión del fluido. Un trabajo DataLog de P-T graba la presión y la fuerza de extracción de 
TensiTrak. Para ver los datos de perforación y de P-T en un informe, ambos trabajos deben 
ser grabados al mismo tiempo para una perforación. Al cargar un DataLog de perforación 
que se grabó simultáneamente con un DataLog de P-T, el software LWD incluye 
automáticamente los datos P-T con los datos de perforación. 

Activar/desactivar la función 
DataLog de perforación 
(verde si está activada, rojo 

si está desactivada) 

Salir 

Cargar el trabajo DataLog 
de P-T a una computadora 

 

Eliminar trabajo(s) DataLog de P-T  

La "p" indica que se ha 
seleccionado un transmisor de 

presión de fluido 
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Grabación de datos  

Para grabar los datos de la perforación piloto, el receptor debe estar recibiendo datos desde 
un transmisor debidamente calibrado, tal como se describe en el manual del operador del 
receptor. 

Asegúrese de que las características de DataLog de perforación y de DataLog de presión-
tensión están activadas, tal como se describe en la nota de la página 4. 

Creación de un trabajo nuevo 

 

Nota Para incluir los datos de presión/tensión con su DataLog de perforación, 
seleccione un transmisor FPT en la pantalla de selección del transmisor y 
regrese a la pantalla Localizar, donde el receptor le pedirá automáticamente 
iniciar un trabajo DataLog de P-T (ver Grabación de los datos P-T en la 
página 21). Cuando regrese a la pantalla Localizar, continúe hacia abajo, 
para iniciar un trabajo DataLog de perforación simultáneo. 

1. En la pantalla Localizar, mantenga el gatillo brevemente y después conmute a la 
derecha para mostrar el menú Iniciar grabación de DataLog de perforación.  

2. Seleccione Crear un trabajo nuevo . 

 

Menú Iniciar grabación de DataLog de perforación 

Crear un trabajo nuevo 
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3. Introduzca en el teclado la longitud de la varilla de perforación (tubería) que se utilizará 

para este perforación, a continuación, seleccione Enter  para establecerla como 

la longitud de la varilla de perforación. 

 

Teclado para introducir la longitud de la tubería (longitud de la varilla) 

Diez pies (3.05 m) es la longitud predeterminada de la varilla. El receptor recuerda la 
longitud de su última varilla. 

4. Aparece la pantalla de entrada de la longitud de la primera varilla con un valor 
predeterminado. Esta longitud se calcula automáticamente como un 70% de la longitud 

de su tubería. Si esto es correcto para su perforación, seleccione  para fijar este 
valor y vaya al paso 5. 

 

Pantalla de entrada de la longitud de la primera varilla 

Enter 

Establezca la longitud de 
la primera varilla al valor 

predeterminado  

Seleccione el teclado 
para introducir un valor 

diferente 

Longitud de la 

primera varilla 
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Nota Si el cabezal de perforación no se puede colocar de modo que las ranuras 
estén la mitad por encima y la mitad por debajo del terreno debido a la 
configuración del herramental de perforación (tal como se muestra en las 
ilustraciones anteriores y posteriores), todavía se puede ilustrar esto más 
adelante en LWD en sus datos de perforación cargados, al abrir Job 
Information (Información del trabajo) (en el menú Edit (Editar)) e 
introduciendo un valor en la casilla Rel. Elev. (Relative Elevation) At Entry 
(Elev. Rel. (Elevación relativa) en la entrada). Por ejemplo, si las ranuras de 
la caja están cuatro pies (1.2 m) por debajo del terreno, introduzca un valor 
de -4 (-1.2). Vea Cambio de elevación del punto de medición en la página 31 
para más información sobre este tema en el software Log-While-Drilling. 

Para calcular un valor de longitud diferente de la primera varilla, mida desde las 
abrazaderas de enganche/desenganche a la parte superior de la varilla, cuando el 
cabezal de perforación se coloque para el primer punto de datos. Para esta medición, 
las ranuras de la caja deben estar, la mitad por encima y la mitad por debajo del 
terreno (o de un plano paralelo al terreno, si se está perforando en un pozo de 
entrada). La elevación en el primer punto de datos es la elevación de referencia cero, y 
está generalmente en la superficie del terreno. 

Seleccione el teclado, introduzca el valor deseado y seleccione Enter . 

 

 

Medición de la longitud de la primera varilla 

Parte superior 

de la varilla 

Ranuras en la caja 

Longitud de la 
primera varilla 

Abrazaderas de 

enganche/desenganche 

Carro de 

perforadora 

Línea de referencia 

de elevación cero  

Superficie 

del terreno 
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5. Al grabar el primer punto de datos (varilla 0), la única opción disponible será Grabar 

inclinación solamente . Con el receptor colocado dentro del alcance del 
transmisor (no tiene que estar en la línea de localización o en el punto de localización 

frontal), seleccione  para grabar el punto de datos. 

 

Opciones de grabación de DataLog de perforación (Inclinación solamente) 

El receptor emite dos pitidos y regresa a la pantalla Localizar. 

6. Avance el cabezal de perforación hasta el extremo de la primera varilla y coloque el 
receptor sobre la línea de localización (LL) o sobre el punto de localización frontal 
(FLP). 

7. Mantenga el gatillo y conmute hacia la derecha una vez para mostrar el menú de 
Opciones de grabación de DataLog de perforación, que ahora cuenta con todas las 
opciones activadas. 

  

Opciones de grabación de DataLog de perforación  

Grabar inclinación 

solamente 

Grabar profundidad/ 

inclinación 

Grabar una 

varilla en blanco  

Grabar inclinación 

solamente 
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8. Seleccione uno de los siguientes: 

 Grabar profundidad/inclinación  para registrar la información de 
profundidad e inclinación. 

 Grabar solamente la inclinación  para registrar sólo la inclinación porque 
usted no puede colocar el receptor en LL o FLP. Esto también es útil cuando se 
perfora por debajo de varillas de refuerzo, las cuales pueden disminuir la 
intensidad de la señal, lo cual puede resultar en valores de topografía incorrectos 
en la gráfica. 

 Grabar una varilla en blanco  si no tiene datos debido a que no se puede 
colocar el receptor dentro del alcance del transmisor. 

Haga clic en el gatillo para grabar el segundo punto de datos (varilla 1). El receptor 
pitará varias veces y regresará a la pantalla Localizar. 

9. Continúe perforando, usando el gatillo/la secuencia de conmutación a la derecha, para 
grabar los puntos de datos al extremo de cada varilla perforada. 

Grabación de varillas parciales 

El software de computadora DigiTrak Log-While-Drilling (LWD) requiere puntos de datos que 
deben ser grabados a intervalos igualmente espaciados, tal como en el extremo de cada 
varilla de perforación. Sin embargo, cuando se perfora con varillas de perforación largas y/o 
se hacen cambios de inclinación importantes, es posible que usted desee grabar datos en 
intervalos parciales de longitud de la tubería para describir con mayor precisión el perfil de la 
perforación y los cambios en la topografía. La función LWD puede admitir longitudes de 
tubería de un cuarto, mitad, tres cuartos y completa. Las varillas parciales sólo podrán ser 
grabadas después de que la varilla 1 (segundo punto de datos) haya sido grabada. 

Para grabar una varilla parcial: 

1. Si es posible, coloque el receptor en el FLP o sobre el cabezal en la LL. 

2. En la pantalla Localizar mantenga el gatillo y conmute a la derecha una vez para ver la 
pantalla Opciones de grabación. 

  

Opciones de grabación de DataLog de perforación (Primera pantalla) 

Grabar profundidad/ 

inclinación 

Grabar una varilla 

en blanco  

Grabar inclinación 

solamente 
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3. Conmute hacia abajo y seleccione Datos en varilla parcial  en la segunda página. 

  

Opciones de grabación de DataLog de perforación (Segunda pantalla) 

4. Seleccione una longitud de varilla parcial.  

 

Pantalla de varilla parcial DataLog 

La visualización regresa a la primera pantalla de opciones de grabación, pero el valor 
parcial de la varilla (¼, ½, ¾, o varilla terminada) aparece en lugar de "Full Rod" 
(Varilla completa) para la longitud de la varilla (ver imagen en el paso 2). 

5. Seleccione la opción para grabar la profundidad y la inclinación (o sólo inclinación si 
usted no puede colocar el receptor en la posición LL o FLP) y haga clic en el gatillo 
para grabar el punto de datos. El receptor emite un pitido varias veces y regresa a la 
pantalla Localizar. 

6. Grabe otro punto de datos en la longitud de varilla parcial o en el extremo de la varilla. 

La opción "Finish Rod" (Terminar varilla) aparece si una varilla parcial fue grabada 
previamente. 

Datos en varilla parcial 

Ver/Eliminar los 

datos de la varilla  

Longitud de la varilla 
(completa, ¼, ½, ¾, o 

terminada, en función de si 
se ha seleccionado una 

varilla total o parcial) 
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Cierre o pausa de un trabajo 

Ambos trabajos de perforación y de P-T deben ser cerrados antes de que puedan ser 
cargados. Cierre un trabajo DataLog de perforación después de grabar el último punto de 
datos y documentar la última varilla.  

También puede poner en pausa un trabajo DataLog por lo que permanece abierto mientras 
navega en las opciones del menú. Todos los trabajos DataLog se cierran automáticamente 
cuando el receptor es apagado. 

1. En la pantalla Localizar, conmute hacia abajo para abrir el menú "Cerrar/Pausar 
grabación DataLog". 
 
Si los datos de perforación y de DataLog están siendo grabados, el menú 
"Cerrar/Pausar grabación de DataLog de perforación" se mostrará primero (se muestra 
abajo), seguido por el menú "Cerrar/Pausar grabación P-T". 

2. Seleccione Cerrar trabajo  para cerrar el trabajo DataLog. El trabajo ahora se 
puede cargar a una computadora (ver Carga de datos a una computadora la página 23) 
o agregarlo más tarde (ver Anexión a un trabajo existente la página 17). 
 
-O- 

Seleccione Pausar trabajo  para mantener el trabajo abierto. Cuando regrese a la 
pantalla Localizar: 

 DataLog de perforación: el siguiente punto de datos grabará en el mismo trabajo 

 DataLog de P-T: los datos se seguirán grabando automáticamente 

 

Menú Cerrar/Pausar grabación de DataLog de perforación 
(mismas opciones que P-T) 

Para incluir un punto de referencia o información de servicios públicos con sus datos de 
perforación, escribir a mano la profundidad, descripción, número de varilla, y/o la distancia 
desde la entrada para cada elemento. Añadir esta información a los datos de perforación 
más tarde, utilizando el software LWD en su computadora. 

Pausar trabajo Cerrar trabajo  
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Nota Un receptor F5 puede almacenar un total de 50 trabajos de 
perforación y 50 trabajos de P-T. El receptor muestra una advertencia 
a los 45 trabajos guardados. Tratar de guardar más de 50 trabajos, 
regresará al menú "Iniciar grabación" donde usted puede anexar a un 
trabajo o salir. 

Anexión a un trabajo existente 

Use Anexar en el menú "Iniciar grabación" para agregar datos a un trabajo DataLog que 
haya sido cerrado o esté en pausa. 

Cuando la función DataLog de P-T está activada y un transmisor de detección de presión 
está en uso, el menú "Iniciar grabación de P-T" se visualiza cuando es accedida la pantalla 
de Localizar. Este menú le permite crear (iniciar la grabación) o anexar a un trabajo 
existente. Este menú es el mismo para la función de DataLog de perforación. 

1. En la pantalla Localizar, oprima el gatillo y conmute a la derecha una vez. 

2. Seleccione Anexar… . 

  

Menú Iniciar grabación de DataLog de perforación (mismas opciones para P-T) 

3. Seleccione el número de trabajo para anexar. 

     

Lista de trabajos DataLog de muestra 

Anexar a un trabajo existente 

"L" muestra los trabajos 
DataLog de perforación; 

"PT" indica un trabajo 

DataLog de presión-tensión 
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4. DataLog de perforación solamente: En la pantalla de opciones de grabación DataLog 
de perforación, seleccione la opción adecuada para continuar el registro de puntos de 
datos. 

5. Continuar la grabación de las varillas de perforación o varillas parciales tal como se 
describió anteriormente en esta sección.  
 
Los datos P-T se continúan grabando automáticamente. 

Visualización y eliminación de varillas del receptor 
1. En la pantalla Localizar mantenga el gatillo apretado y conmute a la derecha una vez 

para ver la pantalla Opciones de grabación. 

2. Conmute hacia abajo y seleccione Ver/Eliminar los datos de la varilla . 

  

Opciones para grabación de DataLog de perforación ("Ver/Eliminar datos de la varilla") 

3. En la lista "Ver datos de varilla", se resaltan los datos de la varilla más reciente (la única 
que se puede eliminar) en la fila superior. Haga clic para seleccionarla (para volver a la 
pantalla Localizar sin eliminar el punto de datos, sólo tiene que conmutar a la izquierda 
o a la derecha). 

  

Lista Ver datos de varilla 

Ver/Eliminar los 

datos de la varilla 

Datos para la varilla 

más reciente 

Punto de medición 
(aparece en blanco a 
menos que el valor 
sea introducido en la 
opción del menú 

Punto de medición) 
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4. Haga clic en  para eliminar el punto de datos de la última varilla, o en Salir  
para cancelar y regresar a la pantalla Localizar. 

  

Pantalla "Eliminar varilla" 

5. Siga estos pasos para cada varilla que necesite eliminar, seleccionar el punto de datos 

más reciente de la lista que se muestra en el paso 3 y  para eliminar. Cuando 
haya terminado de eliminar las varillas, conmute a la izquierda o a la derecha en la lista 
Ver datos de varilla para regresar a la pantalla Localizar. Visualmente confirme que el 
número de varillas utilizadas coincide con la lista Ver datos de varilla. 

Medición y documentación de la última varilla (Opcional) 

Cuando el cabezal de perforación sale del terreno, mida y documente la longitud de la última 
varilla, ya que no fue grabada con los datos de perforación en el receptor. Introduzca este 
valor manualmente en el software LWD después de que se haya cargado el trabajo. 

La medición de la última varilla es la longitud de la tubería menos la longitud de la varilla de 
perforación que permanece en el bastidor. Por ejemplo, si la longitud de la tubería es de 10 
pies (3.0 m) y quedan 6 pies (1.8 m) desde las abrazaderas de enganche/desenganche a la 
parte superior de la varilla, la medición de la última varilla será de 10 - 6 = 4 pies (1.2 m). 

 

Medición de la última varilla 

Abrazaderas de 

enganche/desenganche 

Varillas de 
perforación 

Ranuras 

en la caja 

6 pies (1.8 m) longitud de la varilla 

que permanece en el bastidor 

Superficie de terreno 

(topografía) 

Línea de referencia 

de elevación cero 
Cabezal 
de perfo-
ración 

Punto  

de salida 

Longitud de la tubería 

(10 pies/3.0 m) 

Perfo-

radora 

Parte superior 
de la varilla 

Eliminar el punto de datos 

varilla más reciente Salir 
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Cómo agregar un punto de medición a DataLog de 
perforación  

Si hay una diferencia de elevación entre la entrada y la salida de la perforación, considere 
agregar un punto de medición para corregir cualquier variación de inclinación acumulada que 
pueda afectar la gráfica del perfil. Esto proporciona una gráfica más precisa de la perforación 
y del terreno en el software LWD. 

Desde el menú Principal, seleccione DataLog de perforación, después Agregar punto de 
medición. El punto de medición también se puede introducir más adelante en el software 
Log-While-Drilling, después de la carga de datos (ver Cambio de elevación del punto de 
medición en la página 31). 

1. En el menú de DataLog de perforación , seleccione Agregar punto de  

medición . 

2. De la lista de trabajos de perforación existentes mostrada, seleccione el trabajo al que 
va a añadir el punto de medición. 

3. Seleccione el teclado. 

  

Menú de punto de medición 

4. Use el teclado en pantalla para introducir el valor medido por la diferencia de elevación 
entre la entrada y la salida de la perforación. 

Este teclado incluye un botón "+/-", ya que la diferencia de elevación puede ser 
positiva o negativa. El teclado supone que el valor será positivo, es decir, que la salida 
tiene una elevación más alta que la entrada. Utilice el botón +/- para cambiar, según 
sea necesario. 

5. Seleccione Enter  para fijar el valor que se muestra como el valor del punto de 
medición. La pantalla regresa al menú DataLog. 

 

Nota Más tarde, un punto de medición se puede agregar al trabajo, en el software 
Log-While-Drilling. Ver Cambio de elevación del punto de medición en la 
página 31.  

Establezca el punto de 
medición de vuelta a 

desconocido (el software 
LWD calculará la 

diferencia de elevación) 

Abra el teclado para 
ingresar la diferencia 

de elevación conocida 



DIGITAL  CONTROL  INCORPORATED  

Manual del Operador DataLog/LWD™ DigiTrak 21 

Grabación de los datos P-T 

Seleccionar un transmisor FPT en la pantalla de selección del transmisor del receptor y 
cuando usted accede a la pantalla "Localizar", el receptor pedirá automáticamente crear un 
trabajo DataLog de presión-tensión (P-T). 

Grabación con datos de perforación 
1. En el menú "Iniciar grabación de DataLog de P-T", seleccione Crear un trabajo  

nuevo . El nuevo número de trabajo se muestra en la parte inferior de la pantalla. 

  

Menú Iniciar grabación de DataLog de P-T 

El receptor regresa a la pantalla Localizar y los datos P-T comienzan a grabarse, según lo 
indicado por el icono de grabación junto al indicador de balanceo.  

  

Icono de grabación de los datos P-T 

En la pantalla "Localizar", mantenga pulsado el gatillo brevemente y luego también conmute 
a la derecha para iniciar un trabajo DataLog de perforación simultáneo (vea Grabación de 
datos en la página 10). 

Crear a nuevo trabajo 
(abre la pantalla 
"Localizar"; los datos se 
grabarán de acuerdo con 
el número de trabajo 

indicado) 

Salir (regresa a la pantalla 
del modo localización; no 

se graban los datos) 
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Grabación sin datos de perforación 

Para grabar los datos de presión-tensión solamente, inicie un trabajo DataLog de P-T, tal 
como se describe en la sección anterior, pero no inicie un trabajo DataLog de perforación 
simultáneo cuando regrese a la pantalla "Localizar". 

Debido a que no serán grabados los datos de la varilla de perforación, la gráfica LWD 
resultante mostrará sólo los datos sin procesar de la presión del fluido basados en el tiempo. 

Ajuste de las banderas de datos 

Sólo utilizar banderas de datos con TensiTrak, o al grabar la presión del fluido sin un trabajo 
DataLog de perforación simultáneo. Las banderas de datos ayudan a hacer coincidir los 
puntos de datos a un punto específico a lo largo de la trayectoria de la perforación. 

El menú de grabación de bandera sólo está disponible cuando un trabajo de P-T ya se está 
ejecutando y el receptor está en la pantalla Localizar. DCI recomienda que usted grabe 
banderas en puntos importantes a lo largo de la trayectoria de la perforación, tal como antes 
y después de cruzar por debajo de una carretera o de un arroyo, para ayudar a correlacionar 
las ubicaciones físicas a lo largo de la trayectoria de perforación/extracción con los puntos de 
los datos del archivo P-T. 

1. En la pantalla Localizar, conmute a la derecha para mostrar el menú de grabación de 
bandera. 

  

Menú de grabación de bandera DataLog 

2. Seleccione Fijar una bandera  para grabar una bandera. Una vez que sea 
grabada una bandera, no se puede eliminar del archivo de datos P-T. 

3. Tome nota de los números de la bandera y detalles de la ubicación en la que se grabó 
cada bandera, tales como "entrada bajo el camino" o "borde más alejado del cauce". 
Agregue esta información al archivo de datos P-T, después de que sea cargado en su 
computadora. 

Fije una bandera (graba el 
número de la bandera en la 

pantalla "Localizar") 

Salir (regresa a la pantalla 
"Localizar" sin grabar 

una bandera nueva) 
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Instalación del Software LWD  

Los requisitos mínimos del sistema para el uso del software LWD en una computadora se 
pueden encontrar en la página 3. 

La ubicación predeterminada de los archivos de programa de LWD es c:\Program 
Files\DCI\DigiTrakLWD. Los archivos de datos LWD y los archivos de datos de muestra se 
colocarán en Mis Documentos\DCI. Usted puede cambiar estas dos ubicaciones 
predeterminadas durante la instalación. 

1. Cierre todas las aplicaciones abiertas.  

2. Inserte la unidad flash LWD en un puerto USB y vea el contenido de la unidad. 

3. Abra la carpeta LWD Kit y haga doble clic en Drivers for LWD (Controladores para 
LWD) para instalar los controladores. 

4. Abra la carpeta del controlador Bluetooth y haga doble clic en el archivo *.exe para 
instalar los controladores de Bluetooth (si no ve las extensiones de archivo como .exe, 
haga doble clic en el archivo tipo Aplicación). 

5. Abra la carpeta DigiTrak LWD Software y haga doble clic en el archivo Configuración 
(setup.exe) para instalar el software LWD. 

Una vez que hayan sido instalados estos controladores y el software, aparecerá el icono de 

acceso directo LWD  en su escritorio. 

Carga de datos a una computadora 

Cargar los trabajos DataLog desde el receptor F5 a su computadora implica agregar el 
receptor F5 a la lista de dispositivos Bluetooth del software LWD y luego cargar los archivos 
a la computadora a través de la conexión Bluetooth.  

Para Eclipse: Vaya a Carga de datos desde un receptor Eclipse en la página 26. 
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Añadir el receptor F5 a la lista de dispositivos Bluetooth LWD 

Un receptor F5 debe añadirse a la lista de dispositivos Bluetooth en el software LWD antes 
del primer uso. 

1. Encienda su computadora e inserte el adaptador USB para Bluetooth (Amp'ed RF 
Modelo BT -210) a un puerto USB. 

2. Encienda el receptor F5 y seleccione Información del sistema  en el menú 

principal. 

3. Mantenga esta pantalla abierta, o anote el número de identificación del receptor y la 
dirección del dispositivo Bluetooth. 

  

Pantalla de información del sistema del receptor 

4. Abra LWD haciendo doble clic en el icono de LWD  en su escritorio. 

5. Haga clic en Bluetooth   (menús View > Bluetooth Device List (Ver > Lista de 
dispositivos Bluetooth)) para abrir la casilla de diálogo de la Lista de dispositivos 
Bluetooth. 

Dirección del dispositivo 

Bluetooth 

Número de identificación 

del receptor 
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6. Escriba su Bluetooth Device Address (Dirección del dispositivo Bluetooth) en el 
campo especificado. 

  

Casilla de diálogo de la Lista de dispositivos Bluetooth 

7. En el campo Bluetooth Device Name (Nombre del dispositivo Bluetooth) introduzca el 
número de identificación de su receptor. 

8. Haga clic en Add (Agregar). 

9. Haga clic en OK. El dispositivo aparece en la lista de dispositivos Bluetooth. 

Ahora está listo para cargar los datos del trabajo. 

Carga de datos desde un receptor F5  

DCI recomienda cargar los datos a una computadora después de cada trabajo DataLog. 

1. Abra el menú DataLog para el tipo de archivo de trabajo que va a cargar: datos de 

perforación  o de presión-tensión . 

2. Seleccione Cargar trabajo . 

3. Seleccione el trabajo a cargar 

 

Nota Los datos deben ser comunicados a la computadora dentro de un 
lapso de 15 minutos o el receptor se apagará debido a la inactividad. 

4. Abra LWD haciendo doble clic en el icono de LWD  en su escritorio. 

5. Haga clic en Nuevo  (menús File > New (Archivo > Nuevo)). 

6. Seleccione el tipo de archivo a cargar (datos de perforación o de presión-tensión) y 
haga clic en OK. 

7. En el formulario en blanco que aparece, haga clic en Conexión   (menús File > 
Upload Control (Archivo > Control de carga)). 
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8. En la casilla de diálogo Control de carga, seleccione Bluetooth. 

9. En la lista desplegable Serial Port Connection (Conexión de puerto en serie) 
seleccione Silicon Labs CP210x USB to UART Bridge (COM#). 

10. Seleccione el nombre de su receptor de la lista desplegable Bluetooth. 

11. Haga clic en el botón Connect to Device (Conectar a dispositivo) para comenzar a cargar. 

12. Después de que los datos se hayan transferido, aparecerá la casilla de diálogo 
"DataLog Job Information" (Información del trabajo DataLog). Usted puede ingresar los 
datos solicitados ahora o más tarde. 

13. Haga clic en OK. 

Los datos del trabajo nuevo se muestran en los campos de información y en las áreas de las 
gráficas, en la ventana de la aplicación LWD. 

Carga de datos desde un receptor Eclipse 

Los datos a cargar desde un receptor Eclipse requieren del cable IR ACTiSYS proporcionado 
con el sistema Eclipse DataLog y, si usted no tiene un puerto en serie en su computadora, el 
adaptador de serie a USB. 

1. Conecte el cable IR ACTiSYS en el puerto en serie (COM) en su computadora (o puerto 
USB, si se utiliza el adaptador de serie a USB). 

2. Encienda la computadora y el receptor. 

3. Abra LWD haciendo doble clic en el icono de LWD  en su escritorio. 

4. Haga clic en Nuevo  (menús File > New (Archivo > Nuevo)). 

5. Seleccione el tipo de archivo a cargar (datos de perforación o de presión-tensión) y 
haga clic en OK. 

6. En el formulario en blanco que aparece, haga clic en Conexión  (menús File > 
Upload Control(Archivo > Control de carga)). 

7. En la casilla de diálogo de Control de carga, seleccione Infra-Red (Infrarrojo).  

8. En la lista desplegable "Serial Port Connection" (Conexión a puerto en serie), 
seleccione el puerto de comunicación (COM) asignado al cable IR. 

9. Del menú principal, conmute hacia la derecha y seleccione DataLog. 

10. Seleccione Send Data (Enviar datos). 

11. El receptor muestra el último trabajo registrado. Seleccione el trabajo correcto a cargar. 

12. Alinear el lector IR en el extremo del cable con el puerto IR de color rojo en la parte 
izquierda de la ventana de la pantalla del receptor, a continuación, haga clic en el gatillo 
para iniciar la carga. 

Los datos de perforación aparecerán inmediatamente en la pantalla de la computadora si la 
carga se realiza correctamente. 

Recomendaciones para cargar 

DCI recomienda que cargue los datos de cada operación en dos ocasiones, guardando cada 
una con un nombre diferente. Esto asegura que no importa cuántos cambios realice en el 
archivo en LWD, todavía tendrá una copia original de seguridad para consultar. 
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Si ha grabado un punto de datos mediante la opción de sólo inclinación o de varilla en 
blanco, ese punto de datos aparecerá como datos faltantes. El software LWD hará 
suposiciones para llenar los datos faltantes o usted puede introducir sus propios datos. 

Eliminación de un trabajo DataLog 

1. En el menú de DataLog de perforación , seleccione Eliminar trabajo  

DataLog . 

2. Seleccione el botón para eliminar uno  o todos  los trabajos. 

   

Menú para eliminar los trabajos DataLog 

3. Si va a eliminar un trabajo, seleccione de la lista de trabajos DataLog de perforación y 
de P-T disponibles. 

4. En la pantalla de confirmación, seleccione Confirmar  para eliminar o Salir  
para cancelar. 

 

Pantalla para confirmar la eliminación del trabajo 

Un trabajo eliminado no puede ser recuperado. Asegúrese de que ha cargado los trabajos 
que desea guardar a una computadora, antes de eliminarlos del receptor. 

 

Eliminar un trabajo 

Eliminar todos 

los trabajos 

Salir sin eliminar 

el trabajo 

Confirmar la 
eliminación del 

trabajo 
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Usando LWD 

Iniciar el programa LWD y apertura de archivos 

Inicie el programa Log-While-Drilling (LWD™) haciendo doble clic en el icono de LWD  

en el escritorio. Haga clic en Nuevo  (menús File > New (Archivo > Nuevo)) para iniciar 
un nuevo archivo de trabajo DataLog y seleccione el tipo de archivo de trabajo para 
comenzar: datos de perforación, presión-tensión o direccionamiento. 

Un formulario nuevo de datos de perforación estará en blanco; un formulario LWD con los 
datos, se verá así: 

 

Ventana de datos de perforación LWD 

Haga clic en Abrir   (menús File > Open (Archivo > Abrir)) para abrir un archivo DataLog 
existente. También puede abrir un archivo DataLog directamente desde el Windows 
Explorer, haciendo doble clic en un archivo *.dl5 DataLog de perforación o *.tt5 de presión-
tensión. 

Los menús de Ayuda LWD son una excelente fuente de información en el programa. 
Información detallada sobre la lectura y la edición de los campos de datos se proporcionan 

en los archivos Ayuda . Con el Ayuda de descripción emergente , haga clic en un 
elemento de la pantalla para obtener ayuda con esa función.  

Muchos de los comandos de menú LWD son similares a los utilizados en otros programas de 
Windows, y algunos tienen iconos asociados en la barra de herramientas. Sitúe el cursor en 
cualquier icono en LWD para una descripción emergente que describe su función. Los 
iconos o elementos de menú que aparecen en gris no pertenecen al tipo de archivo DataLog 
actual. Ver Apéndice B – Menú en la página 50 para obtener una lista completa de las 
opciones del menú y sus correspondientes botones de la barra de menús. Por ejemplo, haga 

clic en Unidades en pantalla  (menús Edit > Display Units (Editar > Unidades en 
pantalla) para cambiar las unidades de medida entre pies (ft) o metros (m). 

Barra de menús 

Información 

del sitio 

Información 

del trabajo 

Barra de herramientas 

Área de 

gráfica 

Barra de 

estado 

Lista de puntos de datos 
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Componentes de una pantalla LWD 

Información del sitio  

Haga clic en Información del sitio , o en los menús seleccione Edit > Site Information 
(Editar > Información del sitio), o haga doble clic en el área de información del sitio mostrada 
abajo, para editar esta información. 

   

Información del sitio en la pantalla (izquierda) y la casilla de diálogo 

Toda la información de dirección y de contacto para el trabajo, cliente y contratista se 
enumeran en el informe impreso (ver Cómo guardar, imprimir y enviar su trabajo LWD en la 
página 45 para más información). 

 

Nota La información del sitio permanece de trabajo a trabajo para reducir la 
necesidad de volver a ingresar los mismos datos. Si esta información 
no se guarda de trabajo a trabajo, en especial para las versiones 
posteriores a Windows XP, intente esto: salga de LWD, haga clic con 
el botón derecho en el icono LWD del escritorio, seleccione 
Properties (Propiedades), seleccione la pestaña Compatibility 
(Compatibilidad), marque la casilla "Run this program as an 
administrator" (Haga funcionar este programa como un administrador), 
y haga clic en OK. 
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Información del trabajo 

Haga clic en Información del trabajo , en los menús seleccione Edit > Job Information 
(Editar > Información del trabajo), o haga doble clic en el área de información del trabajo que 
se muestra a continuación, para editar esta información. 

   

Información del trabajo en la pantalla (izquierda) y casilla de diálogo 

La sección de Información del trabajo muestra la información estadística relacionada con el 
trabajo. Algunos campos no se pueden cambiar. 

Date (Fecha) Para un receptor F5, la fecha corresponde al primer 
punto de datos cargados; para un receptor Eclipse, la fecha es 
cuando el trabajo ha sido cargado; para los archivos Eclipse 
importados, es la fecha en que el archivo se ha importado a la 
aplicación LWD. 

Serial Number (Número de serie) Número de identificación o de serie del 
receptor 

Job ID (Identificación del trabajo) Número asignado al trabajo en el 
receptor 

Data Points  (Puntos de datos) Número de puntos de datos recogidos 
(incluye datos insertados manualmente) 

Typical/Default  
Rod Length (Longitud de varilla típica/predeterminada) Longitud de las 

varillas en uso. 

Depth (Profundidad) Unidades de medición que se utilizan para la 
profundidad, pies (ft.) o metros (m) 

Pitch (Inclinación) Unidades de medición que se utilizan para 
inclinación, porcentaje (%) o grados (°) 

Pressure (Presión) Medida utilizada para la presión, libras por pulgada 
cuadrada (psi) o kilo-pascales (kPa) (no se muestran arriba) 

Entry (Entrada) Posición de entrada relativa a las coordenadas (0, 0) 
en las gráficas (distancia positiva o negativa en el perfil 
altimétrico y la posición izquierda (L) o derecha (R) en la gráfica 
de la vista de planta) 
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Información de la longitud de la varilla 

Typical/Default  
Rod Length (Longitud de varilla típica/predeterminada) Los datos de longitud 

de la varilla se incluyen en las cargas del receptor F5, pero se 
pueden cambiar aquí si se ha ingresado de forma incorrecta en 
el receptor.

1 

First Rod Length (Longitud de la primera varilla) La longitud de la varilla para el 
primer punto de datos (varilla 0), que normalmente es una varilla 
parcial. Este valor se determina mediante la medición de la 
cantidad de varilla de perforación que permanece en el bastidor 
de las abrazaderas de enganche/desenganche a la parte 
superior de la varilla cuando la varilla 0 se graba. 

Last Rod Length (Longitud de la última varilla) La longitud de la varilla para el 
último punto de datos, la cual, normalmente, es una varilla 
parcial. Este valor se determina mediante la medición de la 
longitud de la varilla de perforación que permanece en el bastidor 
desde las abrazaderas de enganche/desenganche hasta la parte 
superior de la varilla y luego sustraer esta distancia de la longitud 
de la varilla. Por ejemplo, si la longitud de la varilla que 
permanece en el bastidor es de 6 pies (1.8 m), y la longitud de su 
varilla es de 10 pies. (3.0 m), la última varilla medirá 4 pies. (10 
pies – 6 pies = 4 pies) o 1.2 m (3.0 m – 1.8 m = 1.2 m). 

Cambio de elevación del punto de medición  

Do Not Use  
Reference Elevation (No use la elevación de referencia) Seleccione si la entrada y la 

salida están a la misma elevación. Al desmarcar esta casilla de 
verificación se activa al campo de Elevación de referencia 
(Reference Elevation) debajo de ella. 

Reference Elevation (Elevación de referencia) La elevación de un punto de medición 
geográfica de referencia cerca de la perforación. Si no se 
requiere una elevación de referencia, seleccione la casilla Do 
Not Use Reference Elevation (No use la elevación de 
referencia) para desactivar este campo. La superficie del terreno 
en la entrada del cabezal de perforación será la referencia de 
elevación cero en la gráfica y en la lista de puntos de datos. 
Cuando se utiliza una elevación de referencia, su valor se 
convierte en la referencia cero en la gráfica y en la lista de 
puntos de datos. 

Relative Elevation 
at Entry (Elevación relativa a la entrada) La distancia vertical desde la 

línea de referencia de elevación cero hasta el punto donde la 
perforación penetra en el terreno. En la mayoría de los casos, la 
entrada está en la superficie del terreno. Cuando se utiliza un 
pozo de entrada, este punto está en el fondo del pozo. 

                                                      

1
 Para las cargas del receptor Eclipse, establezca las longitudes de varilla predeterminadas, haciendo clic en el 

botón "Set Defaults" (Configurar predeterminados). Este ajuste se utilizará para todos las cargas nuevas de 
Eclipse. Los cambios realizados en el ajuste de un archivo individual se quedarán con el archivo guardado. 
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Do Not Use  
Exit Survey Point (No use punto de medición de salida) Seleccione esta casilla si 

no hay una diferencia de elevación entre la entrada y la salida. 
La salida será entonces calculada sólo en base a los datos de 
inclinación, varilla y profundidad. 

Rel. Elev. at Exit (Elevación relativa a la salida) La diferencia positiva o negativa 
entre las elevaciones de la entrada y de la salida. Introduzca un 
valor negativo si la salida es más bajo que la entrada; no use un 
símbolo + para un valor positivo. Esta información puede ser 
capturada en el receptor F5 al establecer un punto de medición. 

 

Nota Si se usa un pozo de entrada, incluir la profundidad del pozo en el 
valor de Elev. Rel. en la entrada. Varilla 0 debe ser editada para 
mostrar la profundidad del pozo debajo de la elevación de referencia. 
Si no se utiliza una elevación de referencia, editar la varilla 0, para 
mostrar la profundidad del pozo como la elevación relativa a la 
entrada. 

Lista de puntos de datos 

La lista de puntos de datos es una tabla que muestra todos los puntos de datos en el trabajo. 
En esta tabla usted puede insertar, editar, eliminar, ocultar o sacar puntos de datos 
individuales. Las columnas incluidas en la tabla dependen del tipo de archivo DataLog 
abierto. Vea Componentes de una pantalla LWD en la página 29 y Características de 
DataLog de presión-tensión en la página 40 para obtener más información. 

Área de gráfica 

El área de la gráfica ofrece una representación gráfica de los datos contenidos en la lista de 
puntos de datos. Los puntos de datos ocultos o eliminados no se mostrarán en el área de la 
gráfica. El tipo de datos que se muestran depende del tipo de archivo DataLog y de los datos 
grabados. Los archivos de datos de perforación muestran un perfil altimétrico y, si se utiliza 
un FPT, una gráfica de la presión; los archivos de presión-tensión muestran una gráfica de 
presión y, si se utiliza un transmisor TensiTrak, una gráfica de la fuerza; los archivos de 
direccionamiento (no se tratan en este manual) incluyen un perfil altimétrico y gráfica de vista 
de planta. 

Las características comunes de áreas de gráficas incluyen: 

Puntos de datos Puntos de datos que no se han ocultado o eliminado 

Valores Valor de los puntos contenidos en el área de la gráfica 

Coordenadas del cursor Coloque el cursor en cualquier parte del área de la gráfica para 
ver el valor de las coordenadas en ese punto. Coloque el 
cursor en un punto de datos para mostrar los valores de los 
datos grabados en ese punto. 

Zoom Oprima la tecla de Control y arrastre el puntero a través de un 
área para acercarla. Para regresar a la escala normal, oprima 
Control y haga clic en cualquier parte del área de la gráfica. 
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Edición y anotación en las gráficas 

El perfil altimétrico y las gráficas del presión y fuerza pueden ser editadas y anotadas en un 
diferente número de maneras. Por ejemplo en el menú Edit (Editar) utilice los comandos 
"Annotations" (Anotaciones) para dibujar formas y leyendas directamente en las gráficas 
para describir las condiciones del sitio de trabajo y otros puntos de interés o utilizar los 
comandos de "Properties" (Propiedades) para cambiar los límites de las gráficas.  

Dibujando formas y agregando leyendas 

Para dibujar formas y anotar información en la gráfica y en el informe impreso, sostenga la 
tecla Shift y dibuje una casilla donde desee que aparezca una forma en la gráfica. Esto abre 
una casilla de diálogo de anotaciones que incluye las coordenadas de la ubicación de la 
casilla. 

  

Casilla de diálogo de anotaciones 

Alternativamente, haga clic en Perfil , Presión , o Anotaciones en la gráfica de 

fuerza  (todas en el menú Edit) y anote manualmente las coordenadas de la ubicación. 

Haga doble clic sobre una anotación existente para cambiar sus propiedades (las leyendas 
no pueden ser editadas en esta manera, solamente objetos). 

Seleccione una Shape (Forma) para agregarla desde la casilla desplegable. Ajuste el Line 
Weight (Grosor en la línea) y Font Height (Altura de la fuente) como sea necesario. Utilice 
las casillas de verificación y haga doble clic en las elipses en la sección Draw Shape 
(Dibujar forma) para escoger las propiedades y colores de la forma. 

Seleccione la casilla de verificación Draw Caption (Dibujar leyenda) para activar la sección 
"Caption" (Leyenda). Una leyenda no requiere una forma. Las leyendas aparecen centradas 
predeterminadamente en la forma. Para cambiar la ubicación u orientación de la leyenda, 
utilice los campos Top - Left (Parte superior - Izquierda) y Text Slope (Inclinación del texto). 
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Edición de las propiedades de la gráfica 

Para editar las propiedades tales como límites de gráficas y de escala, haga clic en Perfil 

, Presión , o en Propiedades de la gráfica de fuerza  (todas también en el menú 

Edit (Editar)). 

 

Casilla de diálogo para las propiedades del perfil altimétrico 

Para ingresar diferentes coordenadas de los límites de la gráfica, ponga en blanco una de 
las dos, o ambas casillas de verificación de Auto Scale (Escala automática), y anote nuevos 
valores. 

Lista de puntos de datos 

La lista de puntos de datos es una tabla que muestra todos los puntos de datos en el trabajo, 
en orden secuencial, junto con sus datos asociados. Las unidades de profundidad y de 
inclinación se muestran en la casilla de información del trabajo. Las columnas de la tabla son 
como sigue: 

Rod ID (Identificación de varilla) Número de la varilla y estado del punto 
de datos. Se muestra una bandera de color para indicar el 
estado de los datos:  

 Bandera roja: Inclinación faltante; ingresar la inclinación 
para que la trayectoria de la perforación sea calculada 
correctamente. 

 Bandera magenta: Profundidad faltante; solamente pone de 
relieve los puntos de datos de la inclinación para el 
operador. Abra la casilla de diálogo "Edit Data Point" (Editar 
punto de datos) y haga clic en OK para restaurar esta 
bandera ya sea azul o verde en función de los datos 
introducidos por el operador para la profundidad. 

 Bandera azul: Los puntos de datos han sido editados 

 Bandera gris: Los datos ha sido ocultados o sacados 

 Bandera verde: Datos sobrescritos 

 Bandera negra: Datos originales 

Rod Len. (Longitud de la varilla) Longitud de la varilla 

Bore Len. (Longitud de la perforación) Longitud de la perforación (suma de 
todas las longitudes de varilla anteriores, más la longitud de la 
varilla actual) 
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X Dist. (Distancia X) Distancia horizontal desde la entrada  

Pitch (Inclinación) Valor de la inclinación grabado en el punto de datos 
especificado 

 

Rel. Depth (Profundidad relativa) La profundidad del cabezal de perforación 
por debajo de la línea de elevación cero.  

Depth (Profundidad) La distancia del cabezal de perforación a la 
superficie del terreno. Esta puede ser medida, introducida 
manualmente por el usuario, o interpolada por el software LWD, 
basada en los datos insertados o faltantes. 

Rel. Elev. (Elev. relativa) La diferencia positiva o negativa desde la línea 
de elevación cero. 

Date/Time (Fecha/hora) La fecha y hora en que los puntos de datos 
especificados fueron grabados. Esta información no aparecerá 
en el informe impreso. 

Type (Tipo) Información relativa al tipo de datos grabados en el punto 
de datos: 

 BL: (Blank) En blanco (no hay datos de inclinación o de 
profundidad grabados con el punto de datos)  

 PO: (Pitch Only) Inclinación solamente  

 LL: (Locate Line) Línea de localización  

 FLP: (Front Locate Point) Punto de localización frontal  

 IN: (Inserted data point) Punto de dato insertado. Los 
valores predeterminados de inclinación y de profundidad son 
interpolados a partir de los datos adyacentes y no se 
muestran de forma predeterminada. Estos datos se pueden 
modificar a voluntad al sobrescribir los valores 
predeterminados de la lista. El nuevo punto de datos 
aparece alfabéticamente (tales como, el primer punto 
insertado manualmente después de la varilla número 2 
aparece como 2-A, el segundo como 2-B, etc.). 

Perfo-radora 

Entrada 

Varillas de 

perforación 

Longitud de 

varilla 

Profundidad relativa Línea de 

elevación cero 

Cabezal de 

perforación 

Superficie del 

terreno (topografía) 

Profundidad 

Elev. relativa 
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RawDepth (Profundidad sin procesar) La profundidad proyectada mostrada 
en el receptor 

RawDist (Distancia sin procesar) La distancia horizontal desde donde un 
punto de datos fue tomado, ya sea en el FLP o en la LL para 
apuntar directamente sobre el transmisor. 

Comment (Comentario) Cualquier comentario sobre los puntos de datos 
individuales se puede agregar para mostrarse en esta columna 
(ver Editar varilla/punto de datos abajo). 

Los símbolos en la lista de puntos de datos identifican diferentes tipos de datos: 

o (overwritten) datos sobrescritos manualmente  

e (edited) longitud de la varilla editada  

i (interpolated) datos interpolados  

f (filled in) datos rellenados; los datos faltantes en la carga 
original  

h (hidden) datos ocultados  

x datos de inclinación faltantes  

Edición de los puntos de datos 

Haga clic con el botón derecho en un punto de datos en la tabla para abrir un menú 
emergente con las opciones Edit (editar), Insert (insertar), Delete (eliminar), Hide (ocultar) y 
Remove (sacar). 

 

Menú del atajo para la tabla de punto de datos 
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Editar varilla/punto de datos 

Haga clic con el botón derecho en el punto de datos y seleccione Edit, o simplemente haga 
doble clic en un punto de datos en la lista o en la gráfica. Edite los datos o añada 
comentarios, según sea necesario. Haga clic en OK para guardar los cambios o Cancel 
(Cancelar). 

  

Editar la casilla de diálogo del punto de datos 

Si existe un punto de datos en blanco, la casilla de verificación Pitch is Missing/Unknown 
(Inclinación faltante/desconocida) es seleccionada predeterminadamente. Si usted no 
introduce el valor correcto de la inclinación y desmarca la casilla, habrá un vacío en la línea 
de datos en la gráfica. El punto de datos faltante se hará resaltar en la gráfica. 

Si se inserta una varilla nueva o un punto de datos en blanco o de inclinación solamente es 
grabado, la casilla de verificación Depth is Hidden/Unknown (Profundidad 
ocultada/desconocida) es seleccionada predeterminadamente. Si no se introduce el valor de 
la profundidad y se desmarca la casilla, habrá un vacío en la línea de datos en la gráfica y el 
punto faltante no será mostrado. 

Para recuperar los datos originales grabados, haga clic en el botón Restore Default 
(Recuperar predeterminados) junto a los datos que se van a recuperar. 

Insertar varilla/punto de datos 

Haga clic con el botón derecho en el punto de datos antes de donde el nuevo punto de datos 
se vaya a insertar y seleccione Insert. Un nuevo punto de datos aparece en la lista de datos 
y en la gráfica. 

El nuevo punto de datos será numerado igual que el anterior, con una letra adjunta. Por 
ejemplo, el primer punto insertado manualmente después de varilla 2 aparecerá como 2-A, el 
segundo como 2-B, y así sucesivamente. Los valores indicados para la inclinación y la 
profundidad son interpolados a partir de los datos adyacentes y la profundidad se oculta de 
forma predeterminada. El tipo de varilla se mostrará como IN, para datos insertados. Usted 
puede cambiar los valores de los datos como sea necesario.  

La casilla se marca 
automáticamente si es 
insertada la varilla en blanco 

o para inclinación solamente 

La casilla se marca 
automáticamente si la 
varilla en blanco se 

inserta 

Longitud de la varilla en la 
mismas unidades que la 

medición de profundidad 
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Para recuperar los valores de los datos interpolados originales, haga clic en Restore Default 
(Recuperar predeterminados) según el campo de datos correspondiente. 

Elimine varilla insertada/punto de datos 

Haga clic con el botón derecho en el punto de datos que desee eliminar y seleccione Delete. 
El punto de datos se saca de la lista de puntos de datos y de la gráfica.  

Los datos originales no se pueden eliminar. Si una varilla se graba dos veces 
involuntariamente, seleccione Remove para sacar ese punto de datos. 

Para Eclipse: Los datos del receptor Eclipse son importados, considerados como datos 
originales y no se pueden eliminar. 

Hide (Ocultar) 

Cuando se selecciona esta opción, el punto de datos sigue apareciendo en la lista de datos 
pero no se podrá ver en la gráfica. Los datos, sin embargo, se incluyen en los cálculos. Una 
marca se coloca al lado de la opción, en el menú emergente. 

Remove (Sacar) 

Seleccione esta opción para sacar el punto de datos de la lista, gráfica y de los cálculos. 
Utilice esta opción en los datos originales que fueron grabados dos veces, en forma 
involuntaria. 

Perfil altimétrico 

El perfil altimétrico es una representación visual de los datos de DataLog. 

 

Perfil altimétrico de los datos de perforación 

Puntos de datos 

Los puntos de datos en el perfil altimétrico se muestran con puntos azules. Mantenga el 
puntero del ratón sobre un punto de datos para mostrar los datos grabados en ese punto. 
Haga clic en un punto de datos en el perfil altimétrico para mostrar su fila correspondiente en 
la tabla de puntos de datos. Los vacíos en los puntos de datos indican datos faltantes. 

Los puntos de datos resaltados (puntos con un círculo gris detrás de ellos) indican que una 
varilla ha sido insertada o que la inclinación ha sido editada.  

Los puntos del terreno verdes sólo pueden ser editados para la profundidad, después de lo 
cual también aparecerán resaltados. 

A veces es útil ocultar un punto de datos en la gráfica para permitir que otros elementos 
sean mostrados, tal como una bandera de servicio público. Un punto de datos oculto en el 
perfil altimétrico seguirá siendo mostrando en la lista de puntos de datos. 
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Banderas de servicios públicos  

Utilice banderas de servicios públicos para mostrar la ubicación y el tipo de servicios 
públicos en la gráfica y en el informe impreso. Para agregar o editar banderas de servicios 

públicos, haga clic en Editar banderas de servicios públicos   (menús Edit > Utility 
Flags (Editar > (Banderas de servicios públicos)) para abrir la casilla de diálogo de banderas 
de servicios públicos. Otra manera de hacerlo, es oprimiendo Shift + clic en un punto de 
datos de la gráfica para abrir la casilla de diálogo con la ubicación de una nueva bandera 
especificada automáticamente en ese punto. 

 

Casilla de diálogo de banderas de servicios públicos 

Los campos en la casilla de diálogo de Banderas de servicios públicos son los siguientes: 

Type (Tipo) Seleccione de la lista desplegable. La bandera aparecerá 
en la gráfica como un círculo que usa los colores recomendados 
por la APWA (American Public Works Association - Asociación 
Americana de Obras Públicas). 

X Dist (Distance) (Dist X (Distancia)) La longitud horizontal sobre la superficie del 
terreno, medida desde la entrada hasta el servicio público 

Depth (Profundidad) La longitud vertical desde la superficie hasta el 
servicio público 

Comment (Comentario) La leyenda predeterminada es el tipo del servicio 
público; introduzca un comentario para crear una nueva leyenda. 

Text Slope (Inclinación del texto) El ángulo del texto de la leyenda en la 
gráfica 

No confunda Banderas de servicios públicos con Banderas de datos en archivos de presión-
tensión, que son agregadas por el operador del receptor mientras se graban los datos. 
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Características de DataLog de presión-tensión 

Además de las características descritas en el inicio de la sección anterior, los archivos de 
presión-tensión contienen información y los controles específicos para el registro de la 
presión del fluido (proporcionada por un transmisor sensor de presión) y la fuerza de 
extracción (proporcionada por un transmisor TensiTrak). 

Recuerde: grabe simultáneamente datos de perforación DataLog con un DataLog de P-T 
para refinar sus datos de presión de fluido con los datos del transmisor regulares y crear una 
gráfica lineal más típica, tal como se muestra en la página 5. 

Información del trabajo 

Para agregar y editar información de trabajo que se incluirá en el informe impreso, tal como 
los umbrales límite de presión o tensión permitidos para el trabajo, el tipo de producto 
instalado para un trabajo TensiTrak, y la dirección de los datos graficados, haga clic en 

Información del trabajo  (menús Edit > Job Information (Editar > Información del 
trabajo)) o haga doble clic en la casilla de Información del trabajo. 

  

Casilla de diálogo de información de trabajo Presión-Tensión 

Umbrales del límite de diseño 

Permite introducir límites para valores aceptables de presión y/o tensión (fuerza de 
extracción) grabados durante la perforación y/o instalación del producto. Los umbrales del 
límite de diseño se muestran en el informe impreso. 

Use Tension Design Limit (Use el límite de diseño de tensión) Seleccionar para ingresar un 
valor para la fuerza de extracción máxima permitida para el 
proyecto. 

Use Pressure Design Limit (Use el límite de diseño de presión) Seleccionar para ingresar un 
valor para la presión de fluido máxima permitida para el 
proyecto. 

Con un umbral límite de diseño, los puntos de datos en la lista y en el área de la gráfica 
serán de color amarillo o rojo según el límite del umbral de diseño se acerque o exceda. 
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Información del producto 

Material Detalles sobre el material instalado para un trabajo TensiTrak 

Length (Longitud) Longitud total del producto instalado durante la 
extracción del producto 

Diam (Diám) Diámetro del producto instalado 

Right to Left  

o Left to Right (De derecha a izquierda o de izquierda a derecha) La dirección 
en que los datos se muestran en el área de la gráfica. Los datos 
deben ser visualizados con respecto a la dirección del perfil 
altimétrico de la perforación piloto, para una comparación 
exacta. Seleccione Right to Left (De derecha a izquierda) 
cuando el producto sea jalado desde la salida de la perforación 
piloto. Seleccione Left to Right (De izquierda a derecha) 
cuando los datos de la presión y/o la tensión se graben a partir 
de la entrada de una perforación piloto. 

Lista de puntos de datos 

La lista de puntos de datos es una tabla que muestra todos los puntos de datos en el trabajo, 
en orden secuencial, junto con sus datos asociados. Las unidades de presión y de fuerza se 
visualizan en la casilla "Job Information" (Información del trabajo). Las columnas en la tabla 
incluyen: 

Data Point (Punto de datos) El número y el estado del punto de datos 

Force (Fuerza) El valor de la fuerza grabada por el receptor en el punto 
de datos especificado. Una "x" indica que no hay datos. 

Max F. (F. máx) El valor de la fuerza máxima grabado por el receptor en 
todos los puntos de datos, hasta el indicado. Una "x" indica que 
no hay datos. 

Pres. El valor de la presión grabado por el receptor en el punto de 
datos especificado. Una "x" indica que no hay datos. 

Max P. (P. máx) La presión máxima recogida durante el trabajo hasta 
cuando el punto de datos fue grabado 

Data Flag (Bandera de datos) Marcada si una bandera fue grabada en el 
receptor F5 en un punto de datos especificado 

Date/Time (Fecha/hora) La fecha y hora en que los puntos de datos 
especificados fueron grabados. Esta información no aparece en 
las gráficas o en el informe impreso. 

Para sacar los puntos de datos 

Haga clic en la gráfica en la que desea sacar los puntos de datos. La lista de puntos de 
datos se ajusta para mostrar el grupo de puntos de datos cerca de ese lugar.  

 Para seleccionar un rango de puntos de datos en la lista, haga clic en el primer punto de 
datos, a continuación, haga Shift + clic en el último punto de datos para incluir todos los 
puntos intermedios.  

 Para seleccionar varios puntos de datos que no están en un rango continuo, oprima 
Control y haga clic en cada punto de datos. 
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Haga clic en el botón derecho en los puntos de datos seleccionados, y seleccione Remove 
(Sacar). La lista de puntos de datos indicará los puntos se han sacado de la gráfica. 

Gráfica de presión  

La gráfica muestra la presión del fluido en el fondo de pozo grabada cada cuatro segundos, 
con los datos en el extremo de cada varilla mostrada como un punto verde. Si se establece 
un umbral de límite de presión, los puntos de datos serán color magenta o rojo en tanto el 
umbral de presión se acerque o sea excedido. En este caso, el umbral de límite de presión 
se estableció a 150 psi (vea Información del trabajo en la página 40). 

 

Gráfica de presión de fluido 

Arriba se mostró la presión del fluido de unas gráficas DataLog de P-T, en forma un tanto 
irregular; para una representación más regular, grabe el DataLog de perforación 
simultáneamente (vea Grabación de los datos P-T en la página 21). 

Puntos de datos 

Azul Puntos de datos normales 

Rojo El punto excedió los límites de diseño máximos de presión o de 
fuerza 

Magenta El punto está dentro del 5% de los límites de diseño de presión o 
de fuerza ingresados. Edite los límites de diseño en la casilla de 
diálogo de Información del trabajo que se muestra en la 
página 40. 

Naranja La presión (fuerza) máxima grabada hasta ese punto de datos 

Los puntos de datos dentro de un 15% de la presión máxima o alta se seleccionan 
automáticamente para impresión. Para cambiar esta selección, haga clic con el botón 
derecho en un punto de datos en la lista y seleccione Print (Imprimir) o Don't Print (No 
imprimir). 

Seleccione varios puntos de datos como se señala en Para sacar los puntos de datos en la 
página 41. 

Si bien, usted puede sacar puntos de datos en las gráficas, estos seguirán mostrándose en 
la lista de puntos de datos marcados como "-X". Esto puede ser útil en casos donde se 
recogieron los datos, mientras que la máquina estaba inactiva. Los datos se pueden 
restaurar a la gráfica en cualquier momento. 
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Banderas de datos 

Puntos de datos resaltados — puntos con un círculo verde detrás de ellos — tenían una 
bandera de datos agregada por el operador del receptor. Edite color, etiqueta y ubicación de 
las banderas de datos en la casilla de diálogo de las banderas de datos de presión-tensión, 

al hacer clic en Banderas de datos  (menús Edit > Data Flags (Editar > Banderas de 
datos), o al hacer clic con el botón derecho en el punto de datos en la lista y seleccionar Add 
Data Flag (Agregar bandera de datos), o hacer doble clic en una bandera de datos 
existente). 

 

Casilla de diálogo de la banderas de datos de Presión-Tensión 

Cuando se utiliza un transmisor de presión de fluido durante una perforación piloto y el 
archivo de datos de la perforación también se graba, como se muestra arriba, una bandera 
de los datos se graba con cada varilla nueva o eliminada y marcada como "NewRod" (Varilla 
nueva) o "DelRod" (Varilla eliminada), respectivamente. Usted puede ocultar o mostrar 
banderas de datos para las varillas nuevas y eliminadas en la gráfica de presión. 

Las banderas de datos agregadas manualmente por el operador del receptor, ya sea durante 
una perforación piloto o extracción del producto, se identifican en la gráfica con el número de 
la bandera que apareció cuando se grabó, tal como se muestra en la gráfica de fuerza de 
extracción en la siguiente sección. 

Las banderas de datos agregadas en el LWD se llaman banderas de usuarios. Usted puede 
añadir comentarios a las banderas de usuarios y a las banderas grabadas durante la 
recolección de datos. Las banderas grabadas por el operador durante la recolección de 
datos, no se pueden eliminar.  

 

Nota No hay que confundir las banderas de datos con las banderas de 
servicios públicos. Las banderas de servicios públicos no se aplican a 
un archivo de datos de presión-tensión. 

El punto de datos de la 
ubicación aparecerá en la 

gráfica 
La casilla marcada 
indica que la bandera 
respectiva no aparecerá 

en la gráfica 
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Los campos en la casilla de diálogo de las banderas de datos de presión-tensión incluyen: 

Raw DP Index (Índice PD sin procesar) El número de punto de datos en la lista 
de todos los puntos de datos; no se pueden editar 

Show At Pressure (Mostrar en presión) La presión a la cual la bandera de datos se 
visualizará; si la casilla de verificación está desactivada, la 
bandera no se muestra en la gráfica 

Show At Force (Mostrar en fuerza) La fuerza a la cual la bandera de datos se 
visualizará; si la casilla de verificación está desactivada, la 
bandera no se muestra en la gráfica 

Draw Flag (Dibujar bandera) Utilice las casillas y haga doble clic en las 
elipses en la sección "Draw Flag" para establecer las 
propiedades de formas y colores. 

Haga clic en Change (Cambiar) para guardar los cambios al archivo, después oprima OK 
para salir. Simplemente haciendo clic en OK se cierra la casilla de diálogo sin guardar los 
cambios.  

La bandera editada aparece en la gráfica como un círculo que usa el color elegido en la 
sección "Draw Flag". 

La leyenda predeterminada consiste en el número y tipo de la bandera de datos. Introduzca 
una leyenda diferente en el campo de Comment (Comentario) y cambie el ángulo de la 
leyenda usando el campo Text Slope (Inclinación del texto). 

Por defecto, la bandera de datos se visualiza sobre la presión (fuerza) que se midió cuando 
la bandera fue grabada o agregada. Use las casillas de verificación Show At… (Mostrar a…) 
para mover el marcador separado de los datos medidos, si es necesario. 

Gráfica de la fuerza de extracción  

La gráfica de la fuerza de extracción solamente se muestra para los trabajos TensiTrak. 
Muestra la fuerza de extracción del producto medida en cada punto de datos. Los puntos de 
datos serán de color amarillo o rojo según un umbral de fuerza se acerque o sea superado. 
En el caso siguiente, el umbral límite de fuerza se estableció en 40,000 lb-f (1915 kPa). 

 

Gráfica de la fuerza de extracción 

Los puntos de datos y las banderas de datos en la gráfica de fuerza pueden ser manipulados 
usando los mismos métodos que se usaron para la gráfica de presión-tensión (ver la sección 
anterior). 

Vea el Manual del Operador de F5 TensiTrak DigiTrak para obtener instrucciones completas 
sobre el uso del software LWD con el sistema TensiTrak. 

http://www.digitrak.com/customerservice/downloads.html
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Puntos de DataLog de perforación  

Mantenga el puntero del ratón sobre un punto de datos para mostrar los datos grabados en 
ese punto. Haga clic en un punto de datos en el perfil altimétrico para mostrar su fila 
correspondiente en la tabla de puntos de datos. Los vacíos en los puntos de datos indican 
datos faltantes. 

Los colores y tipos de puntos de datos son los siguientes:  

Puntos de datos verdes La presión media grabada durante esa varilla y cualquier varilla 
grabada y eliminada previamente 

Puntos de datos azules La alta presión grabada durante esa varilla y cualquier varilla 
grabada y eliminada previamente. Este es el promedio más 1 
desviación estándar — esto incluye el 84% de las lecturas de la 
presión (suponiendo una distribución normal). Estadísticamente, 
habrán sido picos ocasionales por encima de esta presión. 

Puntos de 
datos dorados La presión máxima grabada durante la varilla y cualquier varilla 

grabada y eliminada previamente 
Puntos de 
datos resaltados Los puntos con un círculo verde detrás de ellos indican que las 

varillas se han eliminado durante el proceso de recolección de 
datos. 

Los datos de presión no se pueden eliminar. Si un evento de sobrepresión se grabó durante 
una varilla que fue eliminada posteriormente, se fusionará con los datos de la siguiente 
varilla grabada. La identificación de la ubicación del evento de sobrepresión requeriría haber 
grabado el registro de la presión y cargado como un archivo de presión-tensión, que 
contendría las banderas que marcan todas las varillas grabadas y eliminadas. 

Cómo guardar, imprimir y enviar su trabajo LWD 

Cómo guardar los archivos del proyecto 

Para guardar su proyecto, haga clic en Guardar  (menús File > Save (Archivo > 
Guardar)). Si el archivo ya se ha guardado, se volverá a guardar bajo su actual nombre y 
ubicación del archivo. Si el archivo no se ha guardado todavía, ponga nombre el archivo y 
seleccione la ubicación para guardarlo en la casilla de diálogo Save As (Guardar como) y a 
continuación haga clic en Save (Guardar). 

El nombre del archivo predeterminado es DrillData#.dl5 para los archivos de datos de 
perforación y Pressure-Tension#.dl5 para los archivos de la presión-tensión. En ambos 
casos, "#" representa un número que comienza en 1 y avanza automáticamente a medida 
que se guardan los archivos. 

Para guardar un archivo abierto con un nombre o ubicación de archivo diferente, seleccione 
File > Save As. Cambie el nombre del archivo y la ubicación como se desee, a continuación, 
haga clic en Save. 

Para exportar un archivo de texto Unicode de valor separado por una coma (*.csv) para 
usarse en una hoja de cálculo, haga clic en Exportar hoja de cálculo  (menús File> 
Export Spreadsheet (Archivo > Exportar hoja de cálculo)). 

DCI recomienda guardar una copia de cada archivo de trabajo final en una carpeta 
separada, como una copia de seguridad. 



DIGITAL  CONTROL  INCORPORATED 

46 Manual del Operador DataLog/LWD™ DigiTrak 

Impresión y vista previa de los archivos del proyecto 

Para imprimir los datos del trabajo, haga clic en Imprimir  (menús File > Print (Archivo > 
Imprimir)). DCI recomienda seleccionar la orientación Landscape (Horizontal) usando el 
botón de Properties (Propiedades). 

Para una vista previa de las páginas que se van a imprimir, haga clic en Vista previa a la 

impresión  (menús File > Print Preview (Archivo > Vista previa a la impresión)). En la 
ventana de vista previa, haga clic en Print para llegar a la casilla diálogo de impresión o 
Close (Cerrar) para regresar al archivo. 

Para editar las propiedades de la impresión, tales como la impresora, tamaño del papel y 

orientación del papel, haga clic en Configuración de impresión  (menús File > Print 
Setup (Archivos > Configuración de impresión)). 

La página uno del trabajo impreso contiene información del trabajo, tal como la ubicación, el 
cliente y la información del contratista, junto con los datos estadísticos y comentarios del 
trabajo. La página dos contiene gráficas del perfil altimétrico y de la vista de planta. Desde la 
página tres y más adelante, se describen los datos de medición de la topografía y los datos 
de la perforación. Los puntos de datos eliminados no se mostrarán. 

Cómo enviar los archivos del proyecto 

Su archivo LWD del proyecto lo puede abrir cualquier persona que también tenga el software 
DigiTrak LWD. 

Para enviar un informe a un cliente que no tiene el software LWD, instalar un controlador de 
impresión PDF

1
, a continuación, imprima a esta "impresora" para crear un informe 

electrónico que se puede ver en cualquier lector de PDF. 

Como una opción para PDF, los sistemas Microsoft Windows incluyen un "Microsoft XPS 
Document Writer" en la lista de impresoras disponibles. Su cliente requerirá Microsoft 
Internet Explorer para leer este formato PostScript encapsulado (XPS) sin un lector XPS. 
Consulte, por favor http://windows.microsoft.com/en-US/windows-vista/Print-to-the-Microsoft-
XPS-Document-Writer para obtener información adicional sobre el uso de este formato. 

                                                      

1
 Las opciones populares incluyen Adobe Acrobat, CutePDF, Bullzip PDF, and FoxIt PDF; muchas de ellas tienen 
versiones gratuitas. 

http://windows.microsoft.com/en-US/windows-vista/Print-to-the-Microsoft-XPS-Document-Writer
http://windows.microsoft.com/en-US/windows-vista/Print-to-the-Microsoft-XPS-Document-Writer
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Una vez que tenga su escritor PDF preferido instalado (o si usted está utilizando el escritor 
XPS): 

1. Haga clic en Imprimir  (menús File > Print (Archivo > Imprimir)). 

2. Use la lista desplegable de Name (Nombre) para seleccionar el escritor PDF o 
"Microsoft XPS Document Writer". 

 

3. Haga clic en Properties (Propiedades), seleccione la orientación "Landscape" 
(horizontal) (recomendada) y haga clic en OK para guardar la orientación y cerrar la 
casilla de diálogo de Properties. 

4. Haga clic en OK para imprimir (generar) el archivo. 

5. Seleccione la carpeta donde desea guardar el archivo e introduzca un File Name 
(Nombre de archivo). 

6. Haga clic en Save (Guardar). 

Dependiendo de la configuración de la impresión, es posible que aparezca automáticamente 
el archivo PDF generado, o puede que tenga que encontrarlo y abrirlo para verlo. A la 
mayoría de los usuarios les resultará conveniente enviar el archivo PDF a su cliente como un 
archivo adjunto a un correo electrónico. 

Seleccione el 
controlador de 

impresora de la 

lista desplegable 

Seleccione aquí 
la orientación 
horizontal 
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Apéndice A - Símbolos del menú DataLog 

Las siguientes opciones de menú se desempeñan de forma idéntica tanto para las funciones 
estándar de DataLog de perforación y DataLog de presión-tensión (P-T). Los números de 
página a continuación se refieren a la primera página en que el botón se menciona en este 
manual. 

Los botones aparecen en orden alfabético. 

 

Activar/Desactivar DataLog – Cuando se muestra "Enabled, click to disable" 

(Activado, haga clic para desactivar), el icono es verde, la función DataLog está 
activada y usted puede tener acceso a las opciones del menú DataLog en la 
pantalla Localizar. Cuando se muestra "Disabled, click to enable" (Desactivado, 

haga clic para activar), el icono es rojo, la función DataLog está desactivada y no 
ocurrirá registro. Página 4. 

 

Anexar a un trabajo existente – Continúa agregando datos a un trabajo DataLog 

existente. Seleccione el número de trabajo de la lista. Página 17. 

 

Cargar trabajo – Carga los trabajos DataLog a una computadora con el software 

DigiTrak LWD instalado. El receptor puede almacenar un máximo de 50 trabajos 
DataLog según el tipo de archivo (datos de perforación o de presión-tensión). 
Página 25. 

 

Cerrar trabajo – Guarda y cierra un trabajo DataLog. Un trabajo puede ser visto, 

anexado y cargado hasta que sea eliminado de la lista de trabajos. Página 16. 

 

Confirmar eliminación – Aparece después de una solicitud para eliminar trabajos, 

para confirmar la eliminación. Seleccionar para confirmar la eliminación o 
seleccione Exit (Salir) para cancelar la eliminación. Página 27. 

 

Crear un trabajo nuevo – Inicia un nuevo trabajo DataLog. Con la función DataLog 

de perforación, se le pedirá que configure el trabajo con longitudes de varilla. Con 
la función presión-tensión DataLog, la pantalla Localizar y se iniciará el registro. 
Páginas 10 (perforación) y 21 (P-T). 

 

Eliminar todos los trabajos – Elimina todos los trabajos almacenados en el 

receptor. Página 27. 

 

Eliminar trabajo – Elimina el trabajo o los trabajos DataLog seleccionados desde el 

receptor. También utilizado en el menú "Eliminar trabajo" para seleccionar un 
trabajo para eliminar. Página 27. 

 

Fijar una bandera – Graba una bandera mientras un trabajo DataLog de P-T se 

está ejecutando. Las banderas se pueden grabar a intervalos fijos o en puntos 
específicos a lo largo de la trayectoria de perforación, para ayudar a correlacionar 
las ubicaciones físicas con los puntos de datos grabados. Página 22. 

 

Pausar trabajo – Abre el menú principal del receptor, pero mantiene el trabajo 

abierto sin registrar de datos. Los datos se continúan grabando en el número actual 
de trabajo cuando vuelva a entrar en la pantalla Localizar sin apagar el receptor. 

Página 16. 
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Las siguientes opciones de menú se aplican específicamente a la función de DataLog de 
perforación.  

 

Agregar punto de medición – Graba un valor medido para la diferencia en 

elevación (elevación de referencia) entre el punto de entrada y el punto de salida de 
la perforación. Este valor ayudará a proporcionar un perfil altimétrico más precisa 
en el software de LWD. Página 20. 

 

Configurar trabajo – Establece un nuevo trabajo o anexa datos para un trabajo 

existente. Sólo accesible cuando DataLog está activada. Si no se ha iniciado algún 
trabajo DataLog de perforación, esta opción también se puede acceder desde la 
pantalla Localizar manteniendo oprimido el gatillo y conmutando a la derecha.  

 

Datos en varilla parcial – Registra un punto de datos después de terminar una 

varilla parcial. Recomendado cuando se utilizan varillas de perforación largas 
durante los cambios importantes de inclinación o para trazar con precisión 
pequeños cambios en la topografía. Página 15. 

 

Grabar inclinación solamente – Registra sólo la información de inclinación en un 

punto de datos; se utiliza cuando el receptor no se puede colocar sobre el FLP o la 
LL. Esta opción no estará disponible si la información de inclinación no está 
disponible, en cuyo caso se debe grabar una varilla en blanco. Página 13. 

 

Grabar profundidad/inclinación – Registra la información de profundidad e 

inclinación en un Punto de Localización Frontal (FLP) o Línea de Localización (LL). 
Esta opción no está disponible en el primer punto de datos de la varilla y cuando la 
información de la inclinación o de la profundidad no está disponible. Página 14. 

 

Grabar una varilla en blanco – Registra unos puntos de datos sin información de 

inclinación o de profundidad; se usa cuando el receptor no puede ser posicionado 
dentro del alcance del transmisor. Página 14. 

 

Ver DataLog – Muestra datos para un trabajo específico. Página 8. 

`  

Ver/Eliminar los datos de la varilla – Muestra todos puntos de datos registrados; 

le permite eliminar el último punto de datos registrado. Página 18. 
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Apéndice B – Menús 

Barra de menú y Barra de herramientas 

Muchos de los comandos de menú LWD son similares a los utilizados en otros programas de 
Windows, y algunos tienen iconos asociados en la barra de herramientas. Sitúe el cursor en 
cualquier icono en LWD para una descripción emergente que describe su función. Los 
iconos o elementos de menú que aparecen en gris no pertenecen al tipo de archivo DataLog 
actual. Los números de página a continuación, se refieren a la primera página en la que el 
comando se menciona en este manual. 

Menú "File" (Menú de archivo) 

Comando Icono Descripción 

New 
 

(Nuevo) Crear un trabajo nuevo (datos de perforación, presión-tensión o 
direccionamiento). Una vez que se ha realizado una selección, aparece 
una nueva pantalla de trabajo en blanco. Página 25. 

Open 
 

(Abrir) Abrir un trabajo existente. Página 28. 

Save 
 

(Guardar) Guardar un trabajo abierto. Si el trabajo aún no ha sido 
nombrado/guardado, esto abre la misma casilla de diálogo como Save 
As (Guardar como). Página 45. 

Save As  (Guardar como) Guarde el trabajo actual en un nombre de archivo y 
carpeta especificados. Página 45. 

Print  (Imprimir) Imprimir el trabajo. Página 46. 

Print Preview  (Vista previa a la impresión) Mostrar el trabajo en pantalla tal y como 
aparecerá impreso. Página 46. 

Print Setup  (Configuración de impresión) Seleccione opciones tales como una 
impresora, el tamaño y la orientación del papel. Estas opciones están 
por lo general también disponibles en una casilla de diálogo de 
Windows Imprimir bajo un botón llamado Properties (Propiedades). 
Página 46. 

Import Eclipse 
Data 

 (Importar datos de Eclipse) Importar un archivo de DataLog Eclipse 
(*.dld) o archivo TensiTrak Eclipse (*.ttd). 

Export 
Spreadsheet 

 (Exportar hoja de cálculo) Exportar un archivo de texto de valor 
separado por una coma (*.csv) para usarse en una hoja de cálculo. 
Página 45. 

Upload Control  (Control de carga) Enlace a un receptor DigiTrak para cargar archivos. 
Página 25. 

File 1, 2…  (Archivo 1, 2…) Abrir un archivo abierto recientemente. 

Exit  (Salir) Salir del programa de LWD DigiTrak. 
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Menú "Edit" (Menú de Editar)  

Comando Icono Descripción 

Site 
Information  

(Información del sitio) Introduzca y edite la ubicación, información del 
contacto y los comentarios que aparecen en la casilla "Site Information" 
en la esquina superior izquierda del programa. Atajo: haga doble clic en 
la casilla "Site Information". Página 29. 

Display Units 
 

(Unidades en pantalla) Seleccione las unidades de profundidad, 
inclinación, temperatura y de fuerza/presión que aparecen en las 
gráficas de LWD. El ajuste de unidad de profundidad en el receptor 
determinará las unidades mostradas. Página 28. 

Job 
Information  

(Información del trabajo) Ver y editar los detalles del trabajo, incluyendo 
la longitud de la varilla, la información del punto de medición para 
archivos de datos de perforación y la información sobre el producto que 
se está instalando para los archivos de la presión-tensión. Esta casilla 
de diálogo se visualiza inmediatamente después de cargar un archivo 
DataLog. Atajo: haga doble clic en la casilla de "Job Information". 
Página 30. 

Profile  
Chart 
Annotations 

 
(Anotaciones en el perfil altimétrico) Haga comentarios e inserte dibujos 
para que aparezcan en la gráfica del perfil. Atajo: Arrastre sobre la 
gráfica una casilla oprimiendo la tecla Shift. Página 33. 

Pressure Chart 
Annotations  

(Anotaciones en la gráfica de presión) Haga comentarios e inserte 
dibujos para que aparezcan en la gráfica de presión. Atajo: Arrastre 
sobre la gráfica una casilla oprimiendo la tecla Shift. Página 33. 

Force  
Chart 
Annotations 

 
(Anotaciones en la gráfica de fuerza) Haga comentarios e inserte 
dibujos para que aparezcan en la gráfica de fuerza. Atajo: Arrastre 
sobre la gráfica una casilla oprimiendo la tecla Shift. Página 33. 

Profile  
Chart 
Properties 

 
(Propiedades del perfil altimétrico) Ajuste la escala del perfil altimétrico. 
Página 34. 

Pressure Chart 
Properties  

(Propiedades de la gráfica de presión) Ajuste la escala de la gráfica de 
presión. Página 34. 

Force  
Chart 
Properties 

 
(Propiedades de la gráfica de fuerza) Ajuste la escala de la gráfica de 
fuerza. Página 34. 

Utility Flags 
 

(Banderas de servicios públicos) Agregue, cambie o elimine banderas y 
datos relacionados con los servicios públicos. Página 39. 

Data Flags 
 

(Banderas de datos) Cambie o elimine las banderas de datos de P-T. 
Página 43. 

Menú "View" (Menú Ver) 

Comando Icono Descripción 

Toolbar  (Barra de herramientas) Mostrar u ocultar la barra de herramientas. 

Status Bar  (Barra de estado) Mostrar u ocultar la barra de estado. 

Bluetooth 
Device List   

(Lista de dispositivos Bluetooth) Mostrar una lista de dispositivos 
Bluetooth registrados. Página 24. 
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Menú "Window" (Menú Ventana) 

Comando Icono Descripción 

New Window  (Ventana nueva) Abra el archivo actual en una nueva ventana. 

Cascade  (Cascada) Organizar las ventanas en forma superpuesta. 

Tile  (Mosaico) Organizar las ventanas en mosaicos no superpuestos. 

Arrange Icons  (Organizar iconos) Organizar iconos de ventanas minimizadas. 

Window 1, 2…  (Ventana 1, 2…) Ir a una ventana especificada. 

Menú "Help" (Menú de ayuda) 

Comando Icono Descripción 

Help Topics 
 

(Tópicos de ayuda) Un índice de tópicos de ayuda. Página 28. 

About DigiTrak 
LWD 

 (Acerca de DigiTrak LWD) Muestra el número de versión del software 
DigiTrak LWD. 
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GARANTÍA LIMITADA 

Digital Control Incorporated ("DCI") garantiza que, cuando es expedido por DCI, cada producto DCI (diferentes a los productos de software) 
cumplirá con las especificaciones publicadas vigentes de DCI en el momento del envío y estará libre, durante el período de garantía 
("Período de Garantía") descrito abajo, de defectos en sus componentes y de defectos de montaje. Además, DCI garantiza que cada 
producto de software DCI funcionará sustancialmente de acuerdo con las especificaciones establecidas en la documentación de dicho 
software para el Período de Garantía indicado a continuación. La siguiente garantía limitada ("Garantía Limitada") se hace solamente para y 
en beneficio del primer usuario final ("Usuario") que adquiera el Producto DCI directamente de DCI o de un distribuidor expresamente 
autorizado por DCI para vender Productos DCI ("Distribuidor Autorizado DCI") y no es asignable o transferible. 

La Garantía Limitada anterior está sujeta a los términos, condiciones y limitaciones siguientes: 

1. Se aplicará un Período de Garantía de doce (12) meses a los siguientes Productos DCI nuevos: receptores/localizadores, 
visualizadores remotos, cargadores de baterías y baterías recargables, y programas y aplicaciones de software. Se aplicará un 
Período de Garantía de noventa (90) días a todos los demás Productos DCI nuevos, inclusive transmisores y accesorios. Un período 
de garantía de noventa (90) días también se aplicará a los servicios prestados por DCI, incluyendo pruebas, servicio y reparación de 
un producto DCI fuera de garantía. El Período de Garantía comenzará a correr a partir de la última de las siguientes ocurrencias: (i) la 
fecha de embarque del Producto DCI desde DCI, o (ii) la fecha de embarque (u otra forma de expedición) del Producto DCI desde un 
Distribuidor Autorizado DCI al Usuario. 

2. Si un producto DCI (excepto los productos de software) no funciona tal como se garantiza durante el Período de Garantía, DCI 
inspeccionará el producto y si DCI determina que dicho producto está defectuoso, DCI, a su sola opción y discreción, reparará o 
reemplazará el producto. Si un producto de software no funciona tal como se garantiza durante el Período de Garantía, DCI, a su sola 
opción y discreción, llevará al software defectuoso a su cumplimiento material con las especificaciones para este tipo de software, o 
reembolsará el precio de compra pagado por el software defectuoso. LOS ANTERIORES SON LOS ÚNICOS Y EXCLUSIVOS 
REMEDIOS DEL USUARIO PARA EL INCUMPLIMIENTO DE ESTA GARANTÍA LIMITADA. Todas las inspecciones de garantía, 
reparaciones y ajustes deben ser hechos por DCI o por un servicio de reparaciones autorizado por escrito por DCI. Todas las 
reclamaciones a la garantía deben incluir comprobante de compra, incluyendo comprobante de la fecha de compra, identificando al 
Producto DCI por su número de serie, y debe presentarse antes de que termine el Periodo de Garantía. 

3. La Garantía Limitada solamente será efectiva si:(i) dentro de un periodo de catorce (14) días después de la recepción del producto 
DCI, el Usuario registra el producto DCI con DCI a través de su sitio web de inscripción del producto en access.DigiTrak.com; (ii) El 
usuario realiza una inspección razonable en la primera recepción del producto DCI e inmediatamente notifica a DCI de cualquier 
defecto aparente; y (iii) El usuario cumple con todos los procedimientos de reclamación de garantía que se describen a continuación. 

Lo que no está cubierto 

Esta Garantía Limitada excluye todo daño, incluyendo el daño a cualquier Producto DCI, causado por: no seguir las instrucciones del 
Manual del usuario de DCI y otras instrucciones de DCI, uso de un producto DCI fuera de las especificaciones para las que el producto DCI 
está diseñado (incluyendo, sin limitación, la temperatura), maltrato, mala utilización, negligencia, accidente, incendio, inundación, fuerza 
mayor, usos indebidos, conexión eléctrica con voltaje incorrecto y fuentes de alimentación indebidas, uso de fusibles inadecuados, 
recalentamiento, contacto con altos voltajes o sustancias perjudiciales; uso de baterías u otros productos o componentes no fabricados o 
suministrados por DCI, u otros acontecimientos más allá del control de DCI. Esta Garantía Limitada no es aplicable a ningún equipo que no 
haya sido manufacturado o suministrado por DCI, ni, si fuera el caso, a ningún daño o pérdida resultante del uso de cualquier Producto DCI 
usado fuera del país designado para su utilización. El Usuario acepta evaluar minuciosamente la idoneidad del producto DCI para el uso 
deseado por el Usuario y a leer minuciosamente y seguir estrictamente todas las instrucciones proporcionadas por DCI (incluyendo 
cualquier información actualizada del Producto DCI que pueda ser obtenida del sitio Web de DCI). En ningún caso esta Garantía Limitada 
cubrirá daños que surjan durante el transporte del Producto DCI hacia o desde DCI. 

El Usuario acepta que la Garantía Limitada mencionada arriba será nula en los casos siguientes:(i) alteración, extracción o adulteración de 
cualquier número de serie, etiqueta de identificación, instrucciones o precintos en el Producto DCI, o (ii) desmontado, reparación o 
modificación no autorizados del Producto DCI. En ningún caso será DCI responsable del costo de ningún daño resultante de cualquier 
cambio, modificación o reparaciones del Producto DCI que no sea expresamente autorizado por escrito por DCI, y DCI no será responsable 
por la pérdida o daño del Producto DCI o cualquier otro equipo estando en posesión de cualquier agencia de reparaciones no autorizada por 
DCI. 

DCI no asevera ni garantiza la exactitud o integridad de los datos generados por los sistemas de localización de HDD. La exactitud o 
integridad de estos datos pueden ser afectadas por una variedad de factores, incluyendo (sin limitación) la interferencia activa o pasiva 
(incluso la del agua salada) y otras condiciones ambientales, la insuficiencia de calibración o de uso apropiado del dispositivo y de otros 
factores. DCI tampoco garantiza, y se exime de responsabilidad por la exactitud e integridad de los datos generados por cualquier fuente 
externa o derivados de los datos generados por cualquier fuente externa que se pueda mostrar en un dispositivo DCI, incluyendo (sin 
limitación) los datos recibidos desde cualquier equipo de perforación HDD. 

DCI se reserva el derecho de realizar cambios en el diseño y mejoras en el producto DCI de vez en cuando, y el Usuario entiende que DCI 
no tendrá ninguna obligación de actualizar cualquier producto DCI fabricado previamente para incluir dichos cambios. 

mailto:dci@digital-control.com
http://www.digitrak.com/
http://access.digitrak.com/
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LA GARANTÍA LIMITADA PRECEDENTE ES LA ÚNICA GARANTÍA DE DCI Y SUSTITUYE A TODAS LAS DEMÁS GARANTÍAS 
EXPLÍCITAS O IMPLÍCITAS, INCLUSIVE, PERO NO LIMITADO A, LAS GARANTÍAS IMPLÍCITAS DE COMERCIALIZACIÓN Y 
APTITUD PARA UN PROPÓSITO EN PARTICULAR, GARANTÍA IMPLÍCITA DE NO VIOLACIÓN Y CUALQUIER GARANTÍA IMPLÍCITA 
QUE SURJA DEL FUNCIONAMIENTO, TRANSACCIONES, O PRÁCTICA COMERCIAL, TODAS LAS CUALES SE DESCONOCEN Y 
QUEDAN EXCLUIDAS. Si DCI cumplió sustancialmente con los procedimientos de reclamación de garantía descritos más abajo, tales 
procedimientos se constituirán en el único y exclusivo recurso del Usuario por incumplimiento de la Garantía Limitada. 

Limitación de compensación y cobertura 

En ningún caso, ni DCI ni nadie comprometido en la creación, producción o entrega del Producto DCI, será responsable por 
cualquier daño originado por uso indebido o incapacidad para el uso del Producto DCI, inclusive, pero no limitado a daños 
indirectos, especiales, incidentales o consecuentes o por cualquier cobertura, pérdida de información, beneficio o renta, o basado 
en cualquier reclamación del Usuario por ruptura de garantía o de contrato, negligencia, estricta responsabilidad o cualquier otra 
teoría legal, aun cuando DCI sea advertida de la posibilidad de tales daños. En ningún caso la responsabilidad de DCI excederá el 
valor que el Usuario pagó por el Producto DCI. En la medida en que cualquier ley pertinente no permita la exclusión o limitación de 
daños incidentales, consecuentes o similares, las limitaciones precedentes, a respecto de tales daños, no se aplicará. 

Esta Garantía Limitada le proporciona derechos legales específicos y usted podrá poseer además otros derechos que varían de país a país. 
Esta Garantía Limitada se rige por las leyes del Estado de Washington. 

Procedimientos de reclamo de garantía 

1. Si usted tiene problemas con su Producto DCI, en primer lugar debe ponerse en contacto con el Distribuidor Autorizado DCI que le 
vendió el producto. Si no puede resolver el problema a través de su Distribuidor Autorizado DCI, póngase en contacto con el 
Departamento de Atención al Cliente en Kent, Washington, EUA, al 1.800.288.3610 (o, para los mercados internacionales, el número 
de teléfono correspondiente para ese mercado), entre las 6:00 y las 18:00 horas, hora del Pacífico, y pida hablar con un representante 
de atención al cliente. Antes de devolver cualquier Producto DCI a DCI para el servicio de mantenimiento, usted debe obtener un 
número de Autorización de Devolución de Mercancía (RMA). La falta de la RMA puede ocasionarle demoras e incluso la devolución 
del Producto DCI sin reparar. 

2. Luego de entrar en contacto telefónico con un representante de atención al cliente, el representante intentará ayudarlo para resolver su 
problema mientras usted se encuentra trabajando con el Producto DCI en operaciones reales de campo. Por favor, tenga disponible 
todo el equipo de que se trate, junto con una lista de todos los números de serie del Producto DCI. Es importante localizar y solucionar 
los problemas en el terreno de operación ya que muchos problemas no se deben a defectos del Producto DCI, sino a errores 
operativos o a condiciones adversas que se presentan en el medio en el que el Usuario realiza la perforación. 

3. Si, como resultado de las conversaciones con el representante de atención al cliente para localizar y solucionar el problema en 
operaciones de campo, se confirma un defecto en el Producto DCI, el representante expedirá un número RMA autorizando la 
devolución del Producto DCI y le dará instrucciones para el transporte. Usted será responsable por todos los gastos de envío, inclusive 
los gastos de seguro. Si, después de recibir el Producto DCI, y realizar las pruebas de diagnóstico, DCI decide que el problema está 
cubierto por la Garantía Limitada, realizará las reparaciones y/o ajustes necesarios y le enviará de inmediato un Producto DCI en buen 
estado de funcionamiento. Si el problema no está cubierto por la Garantía Limitada, le informará el motivo y le dará una estimación de 
los costos de reparación. En caso que usted autorice a DCI a realizar el mantenimiento o a reparar el Producto DCI, el trabajo será 
efectuado de inmediato y se le enviará el Producto DCI. Todos los gastos de pruebas, reparaciones y ajustes no cubiertos por la 
Garantía Limitada, más los gastos de envío, correrán por su cuenta. En la mayoría de los casos, las reparaciones se llevan a cabo en 
1 o 2 semanas. 

4. DCI tiene existencias limitadas de equipos para préstamo en tanto duran las reparaciones. Si usted solicita un equipo prestado, y 
existen equipos disponibles, DCI intentará enviárselo, por el servicio de entrega en 24 horas, mientras DCI arregla su equipo. DCI se 
esforzará en minimizar el tiempo de inactividad ocasionado por la reclamación de garantía, con las limitaciones de las circunstancias 
que no estén bajo el control de DCI. Si DCI le proporciona un equipo en préstamo, DCI debe recibir su equipo en el plazo máximo de 
dos días hábiles a partir de la fecha en que usted reciba el equipo en préstamo. Usted debe devolver el equipo prestado por el servicio 
de entrega en 24 horas, para que DCI lo reciba no más allá del segundo día hábil a partir de la fecha en que usted recibió su Producto 
DCI reparado. Cualquier incumplimiento en estos plazos tendrá como consecuencia costos de alquiler por el uso del equipo prestado, 
por cada día extra en la devolución del equipo a DCI. 

Demostraciones del Producto 

El personal de DCI puede estar presente en una obra para demostrar el uso básico, las características y los beneficios de los productos de 
DCI. El Usuario reconoce que el personal de DCI sólo estará presente para demostrar un producto DCI. DCI no proporciona servicios de 
localización u otros servicios de consultoría o contratación. DCI no asume ninguna responsabilidad para capacitar al Usuario o a cualquier 
otra persona, y no asume responsabilidad alguna por la localización o cualquier otro trabajo realizado en un sitio de trabajo en el que el 
personal o el equipo de la DCI están o han estado presentes. 

Este documento es una traducción de la versión original en inglés. El propósito de esta traducción es ayudar 
al usuario del producto. Si existiera algún conflicto o diferencia en la interpretación de este documento y el 
original, regirá el original. Una copia de la versión original en idioma inglés se puede encontrar en 
www.DigiTrak.com. Vaya a Service & Support (Servicio y Apoyo), haga clic en Documentation 
(Documentación) y seleccione en el menú desplegable Manuals (Manuales). 

http://www.digitrak.com/

